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2.1 H-JTAG [ 223

F R LU H-JTAG 1 3 71 WWW.HITAG.COM R 8 A 1) H-ITAG 22 Fe )y . — oL,
FUREI AN R4 S (RARIZIP). fi#fE )G, AL E] HITAG 223550 H-JTAGEXE. X% ¢
4, AT DU UG T 2%

HoE, MBS AW, Wk 2-1 Fros. sidi NEXT, sl BLEEA R 230~ —2.

| Installing H-ITAG x|

Welcome to the H-JTAG
Installation!

This sekup program will install H-JTAG ¥0.4.4 (BUILD 20070401}
on your computer, Click Exit if you do not want to install this
application, Click Next ta continue the installation,

WARNING: This program is protected by international copyright
law and treatiss.

Unautharized reproduction or distribution of this program, or
any portion of it, may result in severe civil and criminal penalties
and will be prosecuted to the maximum extent of the law.

e |

K] 2-1 H-JTAG 388 1

w0, AP SFER HITAG AN, WE 2-2 Fros. EFaisazbhil. EREG, HiE
“1 agree with the above terms and conditions”, /x5 . SRJ5 Ml NEXT, o Agh N2 2380~ —235 .
xq

License Agreement ’
To procesd with the installation, you must accept this License J
Agreement. Please read it carefully, v !

a
H-JTAG is a free software For personal use only. Please do not use for any _I
commerdal purpose. Please note that, this program is distributed in the hope that
it will be useful, but WITHOUT ANY WARRANTY, User should be responsible for
any consequences caused.

Install or use this software means you agree with and accept the above terms

and conditions, Otherwise, please stop ko use this software,

All rights reserved,
Copyright {C) Twentyone 2004-2007

I™ 1 agree with the above terms and conditions

< Back | TiExh = | Exit |

K] 2-2 H-JTAG 43518 2

FEH =0, MBI 2-3 Prosiulim. e, A7 ks H-OTAG 122 H ok, st
FIERINI 2238 H ok BRI H o, iy NEXT BEAZE R —20
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# Installing H-JTAG x|

Destination folder
Select a destination Folder where H-1TAG will be installed. J

Setup will install Files in the Follawing Folder.

If wou would like ta install H-JTAG into a different Folder then click Browse and
select another Folder,

"Destination Folder

IC:\ProgramFiIEslH—JTAG Browse... | ‘

< Back | et = I Exit |

2-3 H-JTAG 22015 3

VY, PSS BRI 2-4 PR 2 edb e . R EIRR 23 IEAEEAT, H-ITAG K H 3%
ST DB S
x

Installing Files
Copying H-JTAG files ta your computer. J

To inkerrupk or pause the installation process, click Cancel.

Directory: C:iProgram FilesiH-1TAGFDevicel AMD
File: AM29FS00BE

Tt = | Cancel

2-4 H-JTAG 225018 4

ZRGEE, RSB RIIE 2-5 Frosiiern, RonZ3oE. IR, midi FINISH #tn] L5E
JR i PR 22

| Installing H-1TAG x|

H-JTAG has been successfully
installed!

Thank you for choosing H-JTAG,

Click. Finish to complete the installation,

2-5 H-JTAG 2218 5
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R, BR300 TCEEIR A, H-TAG ¥4 s UNKNOWN, $275 ] 7 H-JTAG JCEERNAR S H bR T A&
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2.3.1 H-JTAG ¥ ANE

W FILE 328, Wil 2-8 Jiix:
il H-ITAG Server ;lglll

:|File § Control Flasher Init Tools Sethings Options  Help
Exit = | = | =
hh Fswemae

2-8 H-JTAG FILE 3¢

+ EXIT - BH H-JTAG.

B CONTROL ', Uik 2-9 Pioks:

fl|H-ITAG Server - = x|
: File |Control | Flasher Init Tools Settings Options  Help

-)(_ *= Reset Target H, 'E, m, E
- Q Detect Target
| 75 Kill Connection

2-9 H-JTAG CONTROL 3.

4+ RESET TARGET — A H bR
+ DETECT TARGET — KR H bR

4+ KILL CONNECTION - WioF4niids:

B FLASHER 3Z#., il 2-10 fios:

r H-ITAG Server

: File  Cantral FIasherhInit Tools  Settings  Options  Help
i = Start H-Flasher =

e QX T il (O
I— &uka Download

2-10 H-JTAG FLASHER 3z .

=10 ]

4+ START FLASHER — A3 H-FLASHER
+ AUTO DOWNLOAD - Ji /251 A5l FLASH F#k

B OINIT 28, Wil 2-11 fiok:

i H-JTAG Server

: File Control Flasher |Init | Tools Settings  Options  Help
Y = | 5 InitScript =
e QA X | F il; (©)

I— Auko Init I
2-11 H-JTAG INIT 3 i

=10l x|

4+ INIT SCRIPT - WEWIIE A
4 AUTOINIT — JA AR A sh il iatl
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B TOOLS ¢, WP 2-12 fiion:

=101 ]

H H-ITAG Server

: File Control  Flasher Init |Taools h Settings  Options  Help
= — Unlock Debug Part {Luminary) i
e QX F

K| 2-12 H-JTAG TOOLS 3z .

4+ UNLOCK DEBUG PORT (LUMINARY) - f#4i LUMINARY i#iR4% 1

B SETTINGS ¥, Wil 2-13 fios:

il H-ITAG Server == x|
: File Control Flasher Init Tools |Settings | Options Help

Y - - -J ¥ USE/LPT Selection
o QX F |5
=& 1USE Jtag Setking
& LPT Jtag Setting

& LPT Port Setting
B Target Setting

W Target Manager
LT TaP Configuration

%] 2-13 H-JTAG SETTINGS

4+ USB/LPT SELECTION - JFH/USB 20k
+ USBJTAG SETTING — USBIJTAG & &

+ LPTJTAG SETTING - LPTJTAG #H

<+ LPT PORT SETTING - FHOwE

4+ TARGET SETTING - WiAHRKE

4+ TARGET MANAGER - NHID &P

<+ TAP CONFIGURATION - TAP H

W OPTIONS 3¢#, Uil 2-14 Ji7R:

fllH-ITAG Server N s o3
: File Control Flasher Init Tools Settings OptionsiHeIp

%-)(_ Qs x Fl s H) -E, i Optians Window |_

©  Connection Maods

Vector Catch Config

U
Cisable Semihosting
Disable Yector Cakch

Report Data Abort:
Disable TAR bkpt @ 0x3

2-14 H-JTAG OPTIONS 3 i

=

+ OPTIONS WINDOW — FTIFIE IR E i

4« CONNECT MODE - T RE

+ VECTOR CATCH CONFIG — R R RCE

4+ DISABLE SEMIHOSTING — 25 SEMIHOSTING Zhfig
4+ DISABLE VECTOR CATCH - ZXJJrhikria) B H 3k T fit
4+ REPORT DATA ABORT — Ja A s i
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+ DISABLE IAR BKPT @ 0x8 — Ja F/ZER AR 7E b hE Ox8 ¥ & W a5

B HELPZH, il 2-15 Fios:

fl|H-JTAG Server N ] =9
: Fil= Control Flasher Inik Tools  Setbings  Options |Help
== | = 2} H-ITAG Home
_AX F S HHD 3
il Check Update
Auto Update

User Manual CN

User Manual EM
[alslulslalsNalalalalsl

a E 3 About H-1TAG

K| 2-15 H-JTAG HELP 3z

+ H-JTAG HOME — Vil H-JTAG F 1T

+ CHECK UPDATE - KA

4+ AUTO UPDATE — FEHMEERE F ke A SR
4+ USER MANUAL CN — FTHH ST F

4+ USER MANUAL EN — FTIFRESCH S F MW

+ ABOUT H-JTAG - KT HJTAG

2.3.2 H-JTAG TERANE

H-JTAG T HA G 1 S Al PR P i AR B0 04, D A o H-OTAG ) R A 1 ]
JIRT

QX Fs HBm 0]
2-16 H-JTAG T HA#*

THEAE RN D BEE R

. e AR H AR

+ X R 5 b

+ K LB RSTPEEER

+ F JF 8l H-FLASHER

<« 3 BBV A

4 M LPT/USB #% 1%+

+ E R ER AR ac

I & 1D E R

+ | FTIF3 0 i 11

+ il B H-JTAG
2.3.3 H-JTAG REFL3kH

M H-JTAG Ho/MuImEiE, F% D& AghlEsk, JERSICE LER HITAG 1IEFr. o8 fdiiz
Klbs, ATLMKE H-ITAG M6 M. A pdiiz b, v LLE R REFCHE R, s 75 H i —ses
VERW B A% . REFTRZE AWK 2-17 Fos:
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Restore

H-1TAG Home

2 About H-ITAG

Options ...
Scripk
Flasher

Kill Connection
Detect Target
Reset Targek

K] 2-17 H-JTAG RZHLA 2

H-JTAG RZATHA DI HEE LW R

+ RESTORE - WEEEN

+ H-JTAG HOME U EE

+ ABOUT H-JTAG - KT HJTAG

4 OPTIONS — TR

+ SCRIPT - A

4+ FLASHER — H-FLASHER 21
4+ KILL CONNECTION — W4 is

+ DETECTTARGET  — Killifik Hbx

+ RESET TARGET — AL H AR

+ EXIT - 1B H-JTAG

2.4 H-FLASHER K7 GUI

H-FLASHER i217Hf, % N 2-18 fros. b (1) Sh3EH; (2) S FLASH 4afe ) S X8 (3)
) FLASH %5/t & X . 7 FLASH Zaftin 524, nfDUEREARI . M 200 m) S rh k£, id
BXIES B RN R E. RKESEELE,

®

=10

Mew Load Save Saveds Options Exit  About

Program Wizard >> Flash Selection

- ADI 4| Wendor: ADI
2 Configuration - AMD Pt
: artha:
3 Irit Scripts - AMIC
¥ P X -- ATIS5AM Tope:
ragranming - ATIISAMI Soctor
5 Pam Options [~ ATMEL ’
b Gereral B EON Block:
i - ES
» On-Chip Flash B FUITSU Page:
» Mand Flash - HYNIX Size:
. - INTEL
» Product H =
racEen - LUMINAFRY o
= H-Flasher Help [ MACRONIX width:
-- WP
-- SAMSUNG |l
-- SPANSION
& 55T
& 5T
[ STM32F
. GTRT LI

2-18 H-FLASHER I %1
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2.4.1 H-FLASHER HI38 /48

H-FLASHER f) =32 5P 2-19 iR
& H-Flasher P ] 4

Mew Load Sawve Sawveds Options Ewxit  About

] 2-19 H-FLASHER 3:37 %

H-FLASHER & Fff) A s LR .

+ NEW — G E S

4+ LOAD — BERNLE S

+ SAVE — DRAF I HTC & S

4+ SAVEAS — BRI AL E S AN
+ OPTIONS - ¥EIETI

+ EXIT - JEH H-FLASHER

+ ABOUT - X7F H-FLASHER

2.4.2 H-FLASHER KRS HEH3¢H8

1 H-FLASHER f/METIIHEE,  F2% D14 A 3IBamek, e RS H6ht bR H-FLASHER W) Ebx. 22
B Z KRR, AT H-FLASHER 3% 0. A diz&bs, nf LS R KRR, Wi 2-20
FioR:

B Restore

2 about...

K 2-20 H-FLASHER &40

H-FLASHER R G LA i) HoAkoe LR .

+ RESTORE - KET%HH
+ ABOUT - XF H-FLASHER
+ EXIT - B4 H-FLASHER

2.4.3 H-FLASHER 4RfE

RAE R A 44 H-FLASHER 42 1A, BARKIBCEIES S R =Sy, ik T Bt
MEBRE =AY . PR EEE SN DR E.

(1) Flash Selection

Flash Selection &4 fLf) F 55—, W R, 76X —, ) FEEMERS I HR G 244
H-FLASHER SZH:IF T FLASH it i #% A2 = 1 20 2512 (NAND FLASH B2, NAND FLASH
VASREL ) Y ke TIOIHE, 47i04 SRz A A G B, Bl 288, 8RN ID 4%,
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(2) Configuration

Mew

Load Save Saveds

Options ~ Exit  About

=101 ]

WY ¥ ¥ ¥ N OE WM

Program Wizard

Configuration
Init Scripts
Frogramming
Fam Optiong
General
On-Chip Flazh
Mand Flash
Production

H-Flasher Help

>> Flash Selection

- ATH1S4M

- ATII5AMTAT

- ATI15AMT7S128
- ATIISAMTSTE
- ATI15AMTSTE]
- ATIISAMTSZEE
- AT15AMTE32
- ATII5AM7SIN
- ATI15AM7SE12
- ATI154MTSE

- AT1SAMTSES2
- ATIISAMT28

- ATI1SAMTXZEE
- ATIISAMTLET2

- ATHSAMTSEZEE

- ATISAMTSEST2

- ATI1SAMTHCT28
- ATIISAM7XC2EE

- ATISAMTACE2
L ATASAMTYE1 79

;I Wendor: ATI154M

Partho: ATS15AMT256
Type:  ON-CHIP FLASH

Sector: 1024
Block:  M/A
Page: M/
Size:  286KB

1D: 0x2758 0340

Width:  32-BIT

=

K| 2-21 H-FLASHER % #% 1] 5 —Flash Selection

Configuration /& 4afe [ FHEE 20, W FEIFR. fExX—5, R EREREAMEE, 6l FLASH
BRI EE, FLASH i astitl, RAM/SDRAM [daatibl, S ahdRisiZe, ¥tk TCK gt TCK
S, IXEEHR NG S, H-FLASHER 241X 2e{5 EoR 5 FLASH £85 . WX AR b 18 1 B AE
K, LN TSR FLASH 5 ok, IR Sefs HAR R E i, AT B . 6 R
W FLASH M 5, XU6f5 AR E 1), SEARANTFEH P,
[Errasher

Mew

Load Save Saveds

Options  Exit  About

=10 ]

Program Wizard

WY ¥ ¥ ¥ N OE W

| 1 Flash Selection

Init Scripts
Frogramming
Pam Options
General
On-Chip Flazh
Mand Flash
Production

H-Flasher Help

>> Configuration

Flazh ‘width = Chip:

Flash Start Address:

R Start Address:

Ext=TAL [MHz):

INIT TCK:

PGM TCK:

|32-Bit # 1-Chip 'I

0x0 -
IDx1 0000000

|12
|250 kHz 'I
|5.D MHz 'I

2-22 H-FLASHER #%i#% ] 5 — Configuration
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(3) Init Script

Init Script JE4RFE I SR =20, W FEPTR. XA BRIl U A L BRI A LA,
FHLARCE H AR RS 7EKES IOH%, H-FLASHER #5562 HUTH M SR MIRA AR, LUGIRA I FRR R4
SRJFAEHRAR T P L (OB B L, bR FLASH E478fE. %4 T 9 FLASH 1%, H-FLASHER 03K 3
Heh S TR, BTOUR AR BRI A . LR, AR SR DI RE S B AR L.

[ i

Mew Load Save Saveds Options Exit  About

1 Flash Selection

Ids | Crmd | width [ Address | Value ]

2 Configuration

Init Scripts

4 Programming
5 Pgm Options
» General

¥ On-Chip Flash
¥ MNand Flazh

» Production

2 H-Flasher Help

-« 3

Kl 2-23 H-FLASHER 4 1] 7 — Init Script
(4) Programming

Programming s&4AE [ SH RIS . EXAPEY R, H AT DO IE e 1 H Ax FLASH i85 5 BT 3
AR AL, Bl BE5. BAE. BEERAS A R R . W YRR kR FLASH, R4
FRNWE 2-24 Frosdeos; WS ETIE RS B8 NOR FLASH 802 N FLASH, P& & 2 W
2-25 s I gmFE S W B S ATk FE A 2 NAND FLASH, 1172 34N & 2-26 T B4 FE AL

([Mrrlasher =10l x|

Mew Load Save Saveds Options Exit  About

1 Flash Selection

2 Configuration

3 it Seripts

Frogramming

Par Options PLEASE SELECT THE TARGET FLASH DEVICE

General
On-Chip Flazh
Mand Flash

¥ ¥ ¥ ¥ uIn

Production

2 H-Flasher Help

2-24 H-FLASHER % ft 7] 5 —Programming (Ki%#¢ FLASH)

USER MANUAL Copyright © 2010 WWW.HJTAG.COM All Rights Reserved 2-10



P 2-25 H-FLASHER % i i) 5 —Programming (3£ 4#% H 4 FLASH 5, NOR FLASH)

MNew Load Save

Save &g

1
=]

x|

Program Wizard

1 Flash Selection
2 Configuration

3 it Seripts

Fam Options
General
On-Chip Flazh
Mand Flash
Production

H-Flasher Help

W ¥ ¥ ¥ ¥ N

=1l
Options  Exit  About
>> Programming - AT915A
Flash: Unchecked Reset
Target: Unchecked Check
Security: UnPratect
Type: IAuto Flash Download j Frogram
Dstédd: | =l Werify
Sriz File: I j
Frarm: IEntire Chip j Eraze
To: IEntire Chip j Blark
Address: I O Read
Size: I

MNew Load Save

Save &g

Options  Exit  About

1
=]

X

Program Wizard

1 Flash Selection
2 Configuration

3 it Seripts

Fam Options
General
On-Chip Flazh
Mand Flash
Production

H-Flasher Help

W ¥ ¥ ¥ ¥ N

>> Programming - S3C244

=1l
Flash: Unchecked Reset
Target: Unchecked Check
Security: nProtect
Type: IF'Iain Binary Format j Frogram
DstAdd:  [Block-0000 x| [Page000D x| Werify
Sriz File: I j
Frarm: IEntire Chip j Eraze
To: IEntire Chip j Blark
From: I j I j ] Read
Te: | =l =

2-26 H-FLASHER %+ [7] 3 —Programming (3% NAND FLASH)

USER MANUAL

Copyright © 2010 WWW.HJTAG.COM All Rights Reserved

2-11



(5) Program Options

Program Options Zwfe 7] T H 12 20, fEIXAMD S, H7a] DURYE FLASH & R H O 22
TEPEAR L. & IR FE AL, —IRIGUER N5 . H-FLASHER [PEI o> s DU, — & F ik
T, RN AN FLASH ROGETR, = Z%%F NAND FLASH FU3ETR, DU AR =ik,

[EETEE———— =00

Mew Load Save Saveds Options Exit  About

Program Wizard >> Pgm Options - S3C

1 Flash Selection

2 Configuration
3 Init Scriptz
4 Programming Flazh Programming Optiorns:
Pam Options - General Options
» General . .
- Options for On-Chip Flagh
¥ On-Chip Flash
- Options for Mand Flash
¥ MNand Flazh
» Production - Options for Production
2 H-Flasher Help

K] 2-27 H-FLASHER 2 F2 [f1] 3 — 4 Fi 38 17

[ eI

Mew Load Save Saveds Options Exit  About

Program Wizard >> Pgm Options - 53C

1 Flash Selection

RESET

Canfiguration .
d ™ Reset the target after programming haz been completed.

Init Scripts
YERIFICATION

d
3
4 Programming
5 ™ Perform second verification by reading after programming.

Parn Options

General SKIP ID CHECK.
» On-Chip Flash I Skip the check of flash id befare all the flash operations.
» Mand Flash ERASE CHIP
¥ Praduction [ Erase entire chip instead of sectors before programming,
2 H-Flasher Help SMART MODE

™ Backup flash data before erasing, and then restore them
during programming.

2-28 H-FLASHER % F4 [7) 5 — 18 ] g FE 16 200
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Mew Load Save Saveds

Options ~ Exit  About

=1o ]

Program Wizard

Flash Selection

Configuration

Frogramrming

1

H

A Init Scripts
Y

5 Pom Optionzs
-

General

Mand Flash
Production
H-Flasher Help

LTI A

>> Pgm Options - 53C244

NP LPC1700/2000

[ Dizable the adjustment of the vectar table check-sum,

ATMEL AT315AM

[~ Set the security bit after programming to enable protection.

ST S5TM32

™ Active the read protection by setting the RDP option byte.

STSTR7X

™| Enable Debug / ReadDut protection after, programing,

K] 2-29 H-FLASHER % f£ 1] 5 — I FLASH 4 126 1l

Mew Load Save Saveds

Options  Exit  About

=101x]

Program Wizard

Flash Selection
Configuration

Init Scripts

Pam Options

1

H

3

4 Programming
5

» General

-

On-Chip Flazh

» Production

H-Flasher Help

>> Pgm Options - 53C244

Frogramming Mode:
¥ Skip bad black and jump to next ane.
" Relocate bad block to reserved area.
Scan of Bad Blocks:

1 Erase and szan the entire fash chip,

) Erase and scan the covered blocks,

Reserved Area for Relocation:

Fromm: I

I
To I j

Reserved Area for User Table:

Fromm: I _ j I
To I j I

I]
I]

2-30 H-FLASHER %if# 7] 5 —NAND FLASH % F#1% i
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Mew Load Save Saveds: Options Exit  About

Program Wizard >> Pgm Options - 53C !

1 Flash Selection
) . PRODUCTION MODE

2 Configuration

. . ™ Enable production made for flash programming.
3 Init Scripts
4 Programming
5 Pam Options ADD ON
» General | Eriatle btlasher add ori.
» On-Chip Flazh | i
# MNand Flash

2 H-Flasher Help

2-31 H-FLASHER % #% 7] 5 —PRODUCTION % 3% 1t

(6) H-Flasher Help

7E H-FALSHER [#)[a) 59, b fit 7 —2eER B B, R NEFR. XA ME BT LA )
T DR E
[Wi-rasher =10l

Mew Load Save Saveds: Options Exit  About

Program Wizard >> H-Flasher Help |

1 Flash Selection
2 Configuation To program flash device, please follow the steps listed below:
T Init Soripts 1. SeIeF:t a flash device
. 2. Configure target eystem
H Frogramming 3. Fillthe scipt for nitalization
5 Par Options 4. Select the pgm options
» General 5. Program/E raze/Check Blank
¥ On-Chip Flash
To view the following helps, please expand [double click] the
# MNand Flash e
et itemm:

¥ Production - Help on flagh selection

H - Help on configuration

- Help on init script
» Flash Selection D i .
) ) - Help on programming

» Configuration -Help on pgm options

» Init Script

¥ Programming

¥ Pom Optoing

P 2-32 H-FLASHER % fi i) 5 —Help
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=% H-JTAG USB {i &%

ARE AN H-JTAG USB 1 B2z 10, MERESEL, ST EZSIAR X 5], F1 USB IK5)
FEFP I 235,

3.1 USB i LA tERES B R

H-JTAG USB /i .83 /& H-JTAG KB\ B vl i —3k s USB #5211 ARM /i B8 . i E45 K USB
B, TFAMERYE. 28 10K~15MHZ f#) JTAG I, 2t s mlik 750KB/S T 50 & 5 f e vl
1k 550KB/S TEHUHE . 5 H-JTAG/H-FLASHER BCAAFH], wlDASEI S il 5 M. i Has RiE, &
B, ROEPELr, BN AT K.

AR
AER USB2.0 #Hil#5+FPGA
ftH: USB £z it
TCK: 10K~15M Hz
B USB 2.0 midisz [
JTAG: FrifE 20-PIN JTAG #:11
CERESS 1.8~5.0V JTAG # 1 Hi &

& EE: H-JTAG USB (i BL & HS0HF s USB 2.0 B,

RAM B Hi G :
ARM?7 - NG R T IA 750KB/S UG R T IA 550K B/S
ARMO - NG R T IA 750KB/S BRHUGHE R T IA 520K B/S
XSCALE - NG R T IA 750KB/S UG R AT IA 520K B/S

CORTEX-M3 -  F#HIERE ik 420KB/S 2B B i =l ik 340KB/S
& FER: PUEEIRAAES 2 Sz ER IR a] e R AT G 0 25 545 AN R B,
1 B2«

H-JTAG USB fij E.as AN an &l 3-1 fron. 22y USB #5211, A kxR 20 £ ITAG $#21.

II. I.

A-JTAB

3-1 H-JTAG USB 1jj E. 234 Wi
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i B8 A=A LED 57547 USB, TGT Fl ACT. X = AMERAT/EH R
A. USB - FriH USB HLJH, HISRIRHA) USB &5,

B. TGT- ki HERRIIZE R, Al LUR SRR H AR GE B2 2 5 1R,

C. ACT - MEFRRLT, WiRINEF R IELEN Hbr REHET ITAG #15.

H-JTAG USB {}i EL21F R I ARAELR 20 &1 JTAG #2101, B E 51058 X R

VREF |1 2] NC

nTRST |3 41 GND
TDI |5 6| GND
™S |7 8| GND
TCK |9 10| GND
NC |11 12| GND
TDO |13 14| GND
nSRST |15 16 | GND
NC |17 18| GND

NC |19 20| GND

K 3-2 H-JTG USB /i E.#% JITAG # 1{5 52 X
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3.2 USB 1 E. 28 i A K X 5]

H-JTAG USB i HLAs 3047 = AMAS, 70 Bl M Jehi, ARAERRCRIIE b . MO A5 AN AT L %

[T T
[N |

A-JTAG

(@) AR

K] 3-3 H-JTAG USB 1/j E. 2% il A4 U X 5]

DX BARA . W BT, R, 350 8 A, R RSN 55 o

(b) FrHEhR

(c) HuRIR

BT HAS A DI BE G N A s T w LURYE H R AT 18 8.

HITAG 1/ .88 ik 4 KR PRERR BRI
X TEEE 5 591 750KB/S 750KB/S
R BREUH B 5 f5F IR0 550KB/S 550KB/S
ARM7 X R S X R
ARM9 XFF RF XFF
CORTEX-M3 SCHE W Y
ABSTH XSCALE AN HF X CRF
ARM11 AN HF AN XFF
PXA3XX AL ANSEHE XFF
PR ADS1.2 RVDS KEIL/MDK IAR
BIERGSHF NT/WIN2000/WINXP/VISTA

% 3-1 H-JTAG USB 1)i EL 28 Th i [X 5]
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3.3 %%k USB 1 E 2SI sh e 7

2B HITAG 7 )5, 78 HJITAG M2 H X N2 —A Driver Hz, XANHXWE T8
WINDOWS ¥ & 1] H-JTAG USB 1j EL25 XS RL e, R A H ] ‘2225 H-JTAG USB 1/7 EL 88 ) B 5l B2 2.

e, ¥ H-JTAG USB 1 Eoagillid USB Zei& RITHSHLAT USB 21 L. v HLRE f5 &3 R LT
FEaf A B TR R 22 2 1)

BAERNEHAS
BB AT

=

AN IR e e
H-JTAG

() mPEHWEERT RS o0 RiE ., FNEE
i HERAL

N R ]
© BN HE T
O WFIFasEir B &E) @

BHE, 1§85 T8 .

2w [ mE |

&l 3-4 Bl m 3

FEI S, WP “ MTIREHEM B 23 (R0 (S 7, WNEPR, RE el “TF—2 (N7

KRBT A5

= E - F RS
H-JTAG

() MBPEREEEAEE o) R, ST
i HEA.

IEHL A
O BshazEge ) @
OPIREREERERE B &

EHE, FHE T—F" .

F—2%w | [ mE |

K 3-5 BEFENFIZR 23
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PRk, A BW R E PR R IR RET A . B RHEHES, 5 “Arixsef E -
RigEWEFEF (S)7. BUN “HRUBsHEAL (. CD-ROM...) (M)”7, % “AEi R uffix/Mir
H 07, [AIE feh N (RY” ¥, FR 1M H-JTAG %¢3% H % N1 Driver SCF2, SR i “ F—20 (ND7,

BHFHBELHG

R R e .

OFFEE PR R E IR ).
{ER AR EIEErRRET RIS , OSSN EeEE. Sk

HRE EIEENE R
Cl#emariEzhfe g, co-rm... )
ERFPEFHTHE Q)
C:WProgram Files\H-JTAG\Driver v

OFEEF. BEOCEEETRHAIENERF D).

TR LUE W S5 Pkt S B2 . Windows TERIRIEIEFRIEIERIIE
shiz Fr SEErneit LA

FH—f@®|[F-f® > [ BHE |
3-6 1 Z ML THAE

FEL R R G, S R PRI IEHE, SR /e 15 0 B ft 22 H-0TAG BK3l. £ N
MEHER, i “pRgksE (C)7, gk,

HEETEEM , g, e

1 ‘E TETE A RB S AR 1 -
L
H-TTa

RUFEEE

TR HYH S VAR R RER S T,
Nicrosoft FRRENASILHZE - HRWHIER
X » ELZEEIBT Yindows HEMEIHEL.

AR Windows HHEINE, » TEMIEER] Windows XP
Fit. EEEA T TIEEEE. )

e

37 W SAA T HE
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K, P 2F 2 EFTR XGRS H-OTAG KSR DA eoe . i “58ik”
A, eI AN

s bl DRSS

FRLBFEAF RS

N
i
IZERCETRE T TR SRR =

H-TTA
=

EXHER ., 5RE ‘T .

K 3-8 S s ke

PESEIN T 228 e, T o] DAST PR B g 04T 25 (TR H g -> A - Jog M-SR -> 15 45 9 D o
WSR2 3 A W) f, AEW S BEgs I, NZAERF] HITAG, WK . WA R &R LG
H-JTAG, i 2 %% H-JTAG IR R P o

O gEEmE (=13
THO RE® SEO "W
N ES 2HE A =ES

o ohIERR ~
e TEHEIERDGE

it

L imlmEs

¢ %0 com F L)

p TARERRERE

+
i
i
i
i
i
< it
.
.
.
.
.
i

i o

=
BEFEE
e AHEEASE
9 FE. METERE R
O BETEEREE
& ERET SRS
Intel (R) ICHI Family USE Uniwersal Host Controller — 2934
Intel (R) ICHY Family USE Uniwersal Host Contreller — 2935
Intel (R) ICHY Family USE Uniwersal Host Contreller — 2936
Intel (R) ICHY Family USE Uniwersal Host Contreller — 2937
Intel (R) ICHY Family USE Uniwersal Host Contreller — 2933
Intel (R) ICHY Family USE Uniwersal Host Contreller — 2939
Intel (R) ICHI Family USEZ Enhanced Host Controller — 2934
Intel (R) ICHI Family USEZ Enhanced Host Controller — 293C
USE Composite Dewice
USE Root Hub w

K 3-9 A BRI HAE
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FEIE H-ITAG HE A B 1

RAFE R4 H-OTAG A ARG E . IR b, a8k, St 7 a e+,
LA Bl L B A R B A

4.1 KR B A

FERTINET, 5¥ H-JTAG USB i HELa5 1B 37 ML USB B2 1 80k ITAG PR/ MG B2 T HLIT 1,
TR HARE L. ZE4TJF H-TAG Ik, H-JTAG £ ASiHATRE/E. H el H-ITAG 1
S T HAEIHATRII . WERAS IR, H-JTAG 3 SRR 45 S 2 (s B 2R 1D, G SRS 2R
WK A H-JTAG % & RIS A4 %

4.2 EALPIR H AR

P aT Lol it H-JTAG SR H AR T = A7 . Fadfk) ITAG 11, & LT HANICLII RN G S RS
AL (nSRST) MITAG 47 (nTRST). WIXMANENAF S, 1 LA BT RS R AR ITAG Hhi. H
JUa] LUEBEHAT KRG E AL JTAG E A7, 8BS [FINFHAT. H-JTAG 4t 7 AN kg il ke, Bkl S
2% H-JTAG ‘i FH LT,

£ BoR:
DU AL 5 11 ITAG I ABRA B BT IR IR S RS 5, FrAAGEIE L H-JTAG UT R E AL, A
M AT B AL A EETE O ITAG WSO R G R AL ITAG RALERAE S, Fr AR AL A
BT RN AT 7RG EALH ITAG Z AL,

43 FLASH B3I F#;

FEe ARM 5, FNEERCT FLASH F1 RAM, JiEM Tk, A5 T RAMBIAAEN L EL, FHXTX
JEBH, Bl LPC2000 %1, AT91SAM7 %541, LUMINARY CORTEX-M3 Z#41Jf1 STM32F #41], H-JTAG
PEHET FLASH AZh F&Ihit. RIAXAThAE, WM mHE T DO RSP S 21 FLASH T, 5t
FHERE R RAM/SDRAM B —#4E. ZfHH A3 FLASH ~N4chRe, WH ) E HITAG Bl AUTO
DOWNLOAD T JF (K 4-1), Ff4F H-FLASHER HLIEFE IEHN) H bR H . WELF A, H-ITAG & A3
MRYEFET T3 bR E S, X Wi sy 75 28 N 48 RAM/SDRAM  Hr J:, MRS 73 75 2L R 3i/ke 'S 31
FLASH 2. F7Zi6ES 3 FLASH 27885y, H-JTAG 2 H 3l H-FLASHER 5S¢ ike’s

File Control |Flasher | Init Tools Settings Options  Help
I Start H-Flasher =

€ Q X UM
Auta Download

K] 4-1 FLASH H3) F s

 BoR:
FLASH A% F#— M 2 S2 8 Iy FLASH, 461401 LPC2000 Fi1 AT91SAM7, Kl kX 245 F (K426 R Gi A0
o S B fR BRI [ 7 o X6 TS BR R S AR L B S B, i MMU/REMAP 45, &30 7 5 T
H-FLASHER 427645 3] FLASH H B 22, SR 5 TR .
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+ BoR:
H-FLASHER LITE A FLASH Hz) F#Ihfe. B FLASH Hzh FEIhRe, EBITAIRE
H-FLASHER.

4.4 FEWIENHA

WF RGOk, bR EHET AT S VAR E R R, AR A e e e, —
A WIS AR 2 A R AL E . KSR, FLASH Fil v i SRAM 76 B #SZ T LLE
i, (H)74h SDRAM T EWERCE, A ReIEMvin . REFFHASMRRET FEA LM A8, &
WL AP AR PG A BIREES? AR H 6?2 AT AR E] MAIN %02 1RZ EHE,
HI A DR A AT W AT i R HAT L BN R o AT REWILHAT PIF I 5k 55— P AE
FLASH 5 F B — B RE R, LHs Ash#aT. X8, RGN R WG HE RS A E LT T,
Al LB AT IR 28 RO ARl W A ACKR S . P AR R T g B L WA A, SRS
I AT A LUK R EAT I A . A% (DEBUGGER) 248t 7447 % 1, JH /7w LUl I iy 4
ITPATIHA A A A TR, H-ITAG Wt T Aahyiinih i Thae. ZH A3tk thne, M e
SE TR EAE H-ITAG T NSV IA, IS AUTO INIT EIRZAH T (B 4-3). IXFE, SRS
(DEBUGGER) 4% H-JTAG (M5, H-JTAG #B4 A BT FH 7 $5 2 AL IEAS , X RGBTV L6k
WA A B 1 B o

Ids | Crnd Wwidth | Address Walue |
T Getmem 328t 0400000000 012345678 :::
*
L]
»
¥
¥ Enable &uto Init MHew | Load | aK | Eancel|
Kl 4-2 It A &
il|H-JTAG Server o ] |

File Control Flasher InitiTooIs Settings  Options  Help

-’é q x I—_ 5 Init Script m, E
Auko Init
— L

K 4-3 Azhbintbthng

+ BoR:
WHRH I T H-ITAG [#) AUTO INIT JEIT, 5048 @ WAL AT, IXFE H-0TAG A %118 Wi $h 47
WIEEAL o G0 RAT I T Zak I, (HEA 2 E VI A, H-JTAG 23471k “Can’t open specified init script”.

+ R
H-JTAG A (R BAKE L, AR BAAS gl TS5 50N

USER MANUAL Copyright © 2010 WWW.HJTAG.COM All Rights Reserved 4-2



4.5 USB/LPT B0 %#

H-JTAG S #:I1 10 JTAG R BORT USB 42 11 H-JTAG 15 EL 2% . 1 ) 5 EARYE [ Ol 1 A4, 16 4% LPT
et USB #: 1, WK 4-4 s,
x|

& LPT [Parallel Part]

£ USE [Univerzal Serial Buz)

QK Cancel

4-4 USB/LPT #2113k %¢

4.6 &HE JTAG

AN IREAA T JTAG B X, LU ITAG IMELE . et 77— ITAG W E 11,
&%,

4.6.1JTAG 5%

JTAG J2 1 1EEE 5 () — AR bR HE, hrvES 8 IEEE-1149, Wi P ARVEG T ZasifE, 155%
IEEE 1] JTAG Fr#fE. ARM JTAG ik M a e LT 7 MEARE % : TMS. TCK. TDI. TDO. RTCK.
nSRST. nTRST. -+ ARM7/9 ()i, TMS. TCK. TDI fl TDO 4k f5 S, 1 RTCK. nSRST.
NTRST AniEfF 5.

+ EE
XSCALE {2k JTAG i Bk nSRST A1 nTRST 124, JEH A E M. S, JoikEdr
Pk

4.6.2 JTAG &E#

H-JTAG i i 5 9 FI/USB #4Z (1) ITAG =il =2k JTAG 5%, FFild 17 H bRt i) JTAG 42 12K
i ARM Ab PR, B ERL N P 4-5 FTon. JorR JTAG 2125 XAE ARM HERTF A MR L1, — AR
FFRUER 20-PIN 5% 14-PIN [ JTAG #:11, AFEM wE . /7l MEA] USB #2111 H-JTAG 1ij 545,
BUEEE T IR ITAG WA . Wi RAE I+ i, F R 2SI 05 JTAG Wl B pkiEse., A

W BEIEZH RPN,
H-JTAG JTAG ARM
SERVER ff 5% Hbs FF A4

] 4-5 JTAG &E8;
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4.6.3 USB JTAG &

H-JTAG USB 1} EL8¢ W HEANHI [ TCK % (10K — 15M Hz), /1T LIAE USB JTAG % B 4G HE B ik
PAEN TCK R, BrTHREREM TCK HR, H W] PLE$ AUTO TCK. MiE#E AUTO TCK ¥
%, H-JTAG 2l R BIE & Hbr RN TCK %,

USB JTAG Setting x|

 AUTO TCK

@ |15 MHz =

QK Cancel

4-6 USB TCK ¥ &

 BoR
TCK M Ik 2 BB IR o AN H bR RGOSR TCK A —HE.. 5i4h, TCKi#
FRAHF ZZ B BB ERAMRARICR. H T EARE Hbs RAEERAIER TCK #2%, 5 MR
ST R AUTO TCK B, H-JTAG Frlfig ik il @i TCK M, Wi R0, 1
FHIEPAR— 2L TCK #%K,

4.6.4 LPT JTAG & &

AT L) 1 ITAG A I3 [l e I ik ], 2 5 H Y WIGGLER Hil SDT-JTAG, kA [ &
FFRLER I . B, 74 WIGGLER SZHFRGEAME S (nSRST), MATLEEIKA . AL I RGELALE
SHITAG EALAE TSI, A7 RS E A — I BT IXFE S DL, H-ITAG $24E T R I3+ 11 JTAG
WE, LSZREAR R 1 ITAG YRR - 75 ZEAR0E 1 S F K ITAG IR AR AT 38, B 75 F H-JTAG
H 5 ITAG VA T 421

I AL T 8 A £l A7 DO-D7, 5 1) Ay o AT AT LA X S 40 R At JTAG #8345 5 : TMS.
TCK. TDI. nSRST. nTRST. Jf LML T JUASIREAL, FLT7 M A FeATTar BUR] A i — A7 >k
BEHL TDO HPRAS. FrLh, JTAG HI% B 2 4 F H-ITAG, 1105 JTAG JAMOE Wi iE R, 1%L
P PRANLH ITAG 5 S 2 W ——X iy e384t T nSRST/nTRST 15 5 1) JTAG Wikt b, SLifES
AT RE LIS R ) = AR = AR R I HSP IR BITRL, T 5 B I B R A 35 U HEOTAG SS9 25
JERIA . IXFE H-JTAG A REIERA AT S ALERAT -

NHEATRE — Moo B ITAG BRI 8 B Wi 4-7 Fros e IR 3RATTAT BLR B FF 1A
JTAG # O PIEFN R, Horp nTRST (5 540k 7 — AN m =K%, 1 nSRST 15 S A KA $E4t.

TMS mmp  JEI0 D1 (PIN3)
TCK mmdp  JEI D2 (PIN4)
mmdp  Ji11 D3 (PING)
TDO mm) i1 BUSY (PIN11)
<= 1] DO (PIN2) JzIf]
X AR
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M\
ST LPT TOI 2 18 R4 51 _TDI
O—5 X |pr RsTIY FT TS ] 1A 1Y1 5 Ao e
o =2 ETTCR 1A2 1¥2 -
[ [PT TCK G 2 R7 51 TCK e
Oz % e sy TDO B 12 RE 51 LPT TDO e
5 7 1A4 1Y4
T4 LPT TCHgp 13 2A 15X
o 1z 15 2 Ny i B
LPT TDI pa NnTRST
o+ = 11 50 2va X — S ERRl
CO—M I TS 7 ? g B
o— ;9 194 2 TCK ? A g
oo ¢ = 74HC244 TDO _ 3 H }42 4
oo—x R3 51 rTRST NSRS 5145 162
© 17 18
I ﬂ 19 20
O
o—122 LPT RST Ri. s 10K 2 Ql 1920 1
T2 N3t CONNFLEX20 -
o123
ol 11 LAT TDCRusY 2
o124
12
O
o265 ¢ I 5
o112 I
DB25 = =

Kl 4-7 F11 ITAG R L % 1]

MR B 4-7 Fros i) JTAG IRBR A L s B R TR 20 BT, JTAG BB T ISR AL N IR ff— Bk B . T
T BCE BB I VR T H-0TAG Jf A JTAG I BB I el 4 ) o

Jtag Settings

—Jtag Selection

™ ‘wiggler [Predefined)

" Sdt.Jtag [Predefined)

3|l )tag Settings

—Jtag Selection

 wiggler (Predefined)
L d

x|
— User Defined Pin Assignment

THS IPin3 D1 'l

—wiggler Pin Assighment

TS IPin3 01 X

= nSRST output inverted

— TCK Cantral

TCK Speed : IMAXJ‘I 'l

nTRST IPin2 i) <z

nSRST IND 5YS AST *

™ rSRET output inverted

" User Defined TCk IF'in4 bz his & User Defined TCk IPin4 D2 'l
— Reset Signal Dutput TDI I Pind D3 - — Fieset Signal Dutput TDI IPin5 D3 vl
¥ nTRST output inverted 100 Bl By < | ¥ nTRAST output inverted o0 Finll Busy =

— TCK Cantrol

TCK Speed : IMAXJ‘I 'l

nTRST IPin2 o] 'l
nSRST IND SvS RST 'l

Ok | Cancel ‘

oK | Cancel |

K 4-8 FE11 JTAG ¢ & 524

FEERAIGE T AN ITAG BLE RIS, B 22% . FESEbe R, TP 5 2R B A
951 ITAG KA HL i B, EAT A R BEE

FEIF T ITAG W E A, ) R aT DR 75 ZE FEAN ] (1 TCK R, BB & D N PR oI
WAL NS, KEMEON, TP AT AR TCK s, I BLE U i ERA SR MAXIL,

Jtag Settings

Jtag Selection————————

& wiggler [Predefined)
" Sdt.tag [Predefined)

x|

—Wwiggler Pin Assignment

TS IP\nB (o]} 'l

" User Defined TCK IF'\n4 0z Vl
— Reset Signal Output TOI IP\nS D3 'l

¥ nTRST output inverted
™| nSRST autput inverted

— TCK.C —_—
TCK Speed : |Max /1 =

ok |

TDO IF'\nH Busy 'l
nTRST IP\n2 o] 'l
nSRST IND SYSRST 'l

Cancel |

Kl 4-9 BE IR TCK B
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4.7 wEIHNO

TR AL, FF D ERIA L REER 2 0x378, (H AT SEp T HHLA I 1 Hb ik AN /& 0x378. H-JTAG 2
BT IEOREG L, T LR A O m 3E I k. RO E S W R PTR. EIE R E O
L IBAT N R AL, AT DUORD e I AR B 1

Port Setting x|

* LP1 - 0378
©LP2 - 04278

e

+" Part Testing

QK Cancel

K 4-10 JFOWE

4.8 BEIFWA HR

H-JTAG it JTAG 2B A 1K 1D, FEHYEIE 1D SRR H AR H 12114 ARM W% . H-JTAG
AT LR B REB 2 0 o Wi H-JTAG AAEHGIER Hbx, )70 LAYE TARGET SETTINGS H T35
& ARM W% . TARGET SETTINGS 1)1 & % 1 Wi & 4-11 Frx.

— ) ARM 5, #BIRIIS 2 KN (Little Endian/Big Endian) . AS[EIEIT R, B Aids A (O 4E0E &
SERANFEN, HARRESZEPEFM . WSBRA /N E A ER, RS eS8, P& EE
TARGET SETTINGS HL i $5 & ik H Ar 19K/ KN LB an F B s :

Target Settings 5'
W
@ Auto Detect

 |ARMTTDMI -

T ndian
@ Litle Endian
" Big Endian

QK | Cancel |

4-11 AR H br i &
4.9 Wit 1D

AT R], H-JTAG MDA 1D SRAIWS A 24 ARM Wi, AR IS, H
SRl AT shiR e H2R A, R, AT DUESETY 1D A8 InE] H-ITAG (s a2 rp2:. XHE H-JTAG
ST LA A SR I o H-ITAG $244t T TARGET MANAGER, I /1 LR 3% AN 4 BE S VR I8 (10385 1 1D,
SMBR CAFAE A 1D B IBT S B 1D, F 7 75 B AR A BE A h N8 1D, 195 2 1% 1D XTIV [ ARM
WH. 58UG, H-ITAG 2 HE B 413 . H-JTAG ) TARGET MANAGER i F i
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Target Manager 5'

& Code

Il Code I
\@rl 'l

—D #izhng |0 Code

|0 Code I vl x
Cloge

K 4-12 AR H b B s

+

+ BN
A5 IEEE 1149 bk, 5 1D 24 32 47, F£ H 1D BsARAL 42004 1. I A] DL X 2ok B0 J 1D
IR [FES, WS A H-ITAG AGEIRBIAC A, WABRHE G ID S R 3|AT, Al
K ISR H-JTAG [ F o4

410 TAP # &

YRR ARM S 5, ARM JTAG HBE AL 1. XX #EES , TAP CONFIGURATION
NZR FHEBIARE, WREFR. TR ARM F55 55 1017 T A5 205 5B ek

TAP Configuration x|

TOl »» | BYPASS |»» | &RM  [»»| BYPASS |»» TDO

GO T A T T
IReq Len: [0 :1' IAuto :1' |n :1'

Drefault | oK | Cancel |

K| 4-13 TAP 2R\ B

HLEE ARM 051 1) JTAG HHfHE S AU PSR AR B L & 3B A (1) ITAG i i e — 1. XL
R R . R IX SSRGS A, T 75 54 TAP CONFIGURATION HLHFTAHNV (¥ & . #il4n, ST
INT STROIXF U5 Fr, HNERIK ITAG FHlEE WK 4-14 Fizn. MR TTLAIE S|, STRIIXF (5 H A3
FEEALHE =37 TAP#L, TAP#2 Fil TAP#3. Hob TAP#2 J& ARM VR 75 E V7 [ (43 Hli%E. 7£ ARM 1331
B P U TR i T2 ER R T R, AT HR A T AR AR IR 4 S 5-Bit AT 8-Bit. X STRILXF it v ifii
i, TAP CONFIGURATION Wi B R 4-15 fiin. Kl 4-15 (e 5 UF H-JTAG, 75 ARM H$i5E 2 i
B4 EE, TR SRR K Y 5-Bit, 78 ARM FHE8E I o Tt — &0 0 deE, IR 4 1
AN 8-Bite IXKf, H-JTAG AN X Wi IEA# 15 0] STRIIXF P91 ARM i1k
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TCK » TCK * TCK » TCK
™S » TMS L» TMS L» TMS
TAP #1 TAP #2 TAP #3
Boundary Scan ARM DEBUG Flash Memory
IR=5 IR=4 IR=8
TDI —» TDI TDO » TDI TDO » TDI TDO —»TDO
nTRST NTRST nTRST

nTRST T T T

4-14 STROIXF FA4HBE N B 4544

TAP Configuration |

TDI »» | BYPASS | > | ARM #» | BYPASS | TDO

Ll Lk

Default | ok | Cancel |

K 4-15 TAP ¥ & (STRIO1xF)
4.11 H-JTAG & P& TR
H-JTAG #2487 —4e F e gt k6. 7 vl DU R i 00w ' R o I AT W e, e DL

OPTIONS S HidbAT PRkl B o REIRBEE % W N B Fos. I Al DUAE 2 00 i 130k 6 5 U AL (R e 000
SRIGAEA LT AT B

x|

Semibosting
Yector Catch . "

[ Disable 5emihosting
Data Abort

I ake:

If pou don't need zemihosting for debugging,

you can dizable it here.

ak. | Cancel

K 4-16 ZEINBEE T 1
H-JTAG $#&4t T JLANH kT
B CONNECTION MODE i% &

R IHEE, )7 a7 CONNECTION MODE HLEFEA [m] (3% 7 e H-JTAG SCHEEA [a] i A5t
X, L PR R R
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B VECTOR CATCH # &
H-JTAG %4 B VECTOR CATCH, WI¥ 4-17 sk, 7t VECTOR CATCH # & L, HI/7 nf LLEFEAE
PR R A 7 A AR P e . B4 )5 DISABLE VECTOR CATCH &gk f#ift, VECTOR
CATCH [ B 4k 20065

X

— ARMYAARMESAS CALE

(IR I I W W I
R U s P D | F

— CORTEX-M3

[~ RESET [~ STATERR
[~ MMERR [~ BUSEFRR
[~ MOCFERR [~ INTERR
[~ CHKERR [~ HARDERR
oK | Cancel |

| 4-17 VECTOR CATCH &

B DISABLE SEMIHOSTING

Semihosting & — Al B RAALE], FRSILENE HAR T AR o (H 75207 FLAs A H AR FE P e
A FSZHE, 1 H Semihosting HAEFHZE R L, ZESEBRI S O ANREAE Y. KA Semihosting 2
P ASER, R SOH e R A e 28 4% T B

B DISABLE VECTOR CATCH

Vector Catch J& I RAMFR AW (1. WERATIF 7%k l, JFfAE Mot B C AR 308, ARM AL PEE:
LSRR, Rt s 7 HBL T % . Vector Catch 2 by IWT s B3, 2 WU 4E
IR R, 2RI IR .

B REPORT DATAABORT
R R b, RELE CPU (5 ILIS AT I I, TR ZEN A7 RTINS, Bl v B4 BT A
TEXAEAEIEAT IS (W%, AT Be 2 LA S o i, U ) oK e SUIIAAA 2 ), B U7 ) 52 AR 4
FIFEAE 2 1) W 4T JF T REPORT DATAABORT JE3, H-JTAG 764l 3 80 7 5 i i, #5243
PR B0, HITAG FURAEW BT RE, AR . P AT DRSS A G 75 2371k
#.

B DISABLE IAR BKPT @ 0x8

JIIAR BRI AR, 1AR S fEHull 0x8 B — M, XMW RAE 1AR HIWT iF R HLEE AL .
PG £ AW B (E FLASH YT BARI I A%, W el DEJ50E 7 LU 9K B IX AR I
FRTLAEFEAR I |AR fEMAE Ox8 BB W it, ATt — W Bt I st A 1

412 TOOLS TH

TOOLS it T —2em IR0 T H . HAr, B HSZE 81 LUMINARY 241810 . PGSR
P P T SR T Y R .

USER MANUAL Copyright © 2010 WWW.HJTAG.COM All Rights Reserved 4-9



4.13 M BERMHTEHT

it H-JTAG ) CHECK UPDATE S i, P a] UK &5 A& A B AR T BA N 4. a1 A S B A,
H-JTAG & -H 7 Fa. F el LLvs a) H-JTAG [ 5 08 LASRAS 55 22 1R 5 345 R
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EHE H-FLASHER {8 FH I B 1R

EANEHVEAANH T H-FLASHER ffdi AL E . [A] a3t 7 g ANe & e, At &2,
5.1 H-FLASHER T2
H-FLASHER ) T4 R #EAR faj o, AL an &l 5-1 Frow o H-FLASHER 1) TAESURE 4> 4 DU/ = 22120 B

HATWIEAL A . R4 FLASH %85 IR Zh L)% 2 RAM. #7F FLASH ID Rt FLASH $UAT H 7 45 52 [ ERA4E .
WSARfT— AN BB AY, H-FLASHER #82Himatis, Tl miieqE.

Execute Check
Init Script Flash ID

Is ID
Correct?

Stop Stop

Download Erase

Flash Driver or
Program

or

Check Blank

Stop Stop

Complete
Successfully

K 5-1 H-FLASHRE T it F
5.1.1 Execute Init Script

WERA R E T WA, H-FLASHER B G AT IR @ AR L IIAS . R ) Bef $a 2 4
UEARIEAS, BORANTE EA ARV AGLIA, H-FLASHER 2 BBkt iX—20 . AEWIAIL I, S
A AT AR I i A, H-FLASHER 25 I 29 AT O34, IR it WRAIanbish, WvE#
N4 FLASH K3 .

5.1.2 Download Flash Driver

WITEAL5E S, H-FLASHER 23R4 F 1361 FLASH U5 FIf7 58, A AN (IIRE) . SR EIIKE)
FEEIH P ¥R E 1 SRAM/SDRAM H s R RHEURTh, WIEHEN T —2; A IUME R i ERE, R

J*: Can’t download driver to specified address.
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5.1.3 Check Flash ID

FLASH KR R #0825, H-FLASHER £ L3:H FLASH (1) 1D. XFEMEAMET, —RZE&E
EFRE R IE PR ARV FLASH; —JEilid 1D SRAIWH ik FLASH SRS HAR R4 LK
FLASH ‘05 25 —3. W8 H-FLASHER BEHUH 1D FISEFRI FLASH ID A—3,  FH 7t n] DLAE g f iz 1
3% $¢ SKIP ID CHECK.

5.1.4 Read/ Erase/ Program/ Verify/Check Blank

FETT 2L BEAR BRI AT, H-FLASHER o4 A1 ISR FLASH 5 B AT AR (R 545, 491
e BEEL, BERR, gfE, RGN AT FLASH = 0. BAESSS, S 82 15 ).

5.2 H-FLASHER Zf2H &

H-FLASHER 24t T g m 5, LU S E MBS FLASH. ) a] LL—25— 5 13 R gm B 1) S 4
ML HAN DRI TR « L4 T H-FLASHER HI3EAR TAERAL G, FIHPEBAHEgRmEL 1 S A DB,
AT TR E .

5.2.1 Flash Section

FERXASD IR, H P 75 24 FLASH 13k BLIEPEAI N FLASH & /45, FF#f 72 H-FLASHER $&4Ht
0 A5 BT H AR R4 FLASH 2 A A5 S 2 — 801 o R AN [ i FLASH (0 F € T ASRERE 4
BT CLIE R FLASH 5 5 8 SR d gL,

5.2.2 Configuration

FERXASL B, P 2R AL EAS B, B85 FLASH L5885 )1 2R, FLASH Ui dh il
RAM [fiE oL, S0 i e (K 3RS [T BURE 1) TCK A,

(1) BLFEA FLASH R $E
A7} 8 FLASH (915 5 #AE RN SRR 1R 58, #1401 8-BIT.  16-BIT 5% 32-BIT. W1 FLASH {5
PSRRI R0, 75 P AR SPRI TR e B FLASH SRR DRl /R IR 4%,
FLASH TAEMALSEA—FF, FLASH RS 3RE AT HTIC0 . W Hbs FLASH (& 5 Hscf— it 5 Jy
Ko WIATESRE . 5350, B, AR 2 78l i FLASH Z1pe—/> 2B 5K 47 fil
B, X T2 I, P 6 7 B W 5

(2) FLASH At

H-FLASHER TFZEL41E FLASH [ffcanhl, A GEX) FLASH AT IEMM#EAE. BTk, PR EfR e
FLASH [tttk . H-FLASHER 234 FH 7 4 R 4 ik A1 FLASH (755 H 8115 FLASH 11
A 3k hE 25 ) : FLASH START ADDRESS ~ (FLASH START ADDRESS + SIZE — 1), % FLASH H4T
HEAERIRAE, ARSI ATEXAEE N, H-FLASHER #3427~ OUT OF RANGE %1%
KB OL T » FLASH #0] LUk 0XO0 5 il , 1 AN TF 2407 Al (A1 4640 o (0 AT 48 H b R 48 3 REMAP,
Al LA FLASH P& BIA A il o 5T TXFE RS, H P 5 EORIE T E 1 FLASH A2 4f Mok 534 (1)
WILEA AR AT — 201, DAt
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(3) RAM 24l
FEREE I I, FLASH 35 75 ZA8 ] 4KByte (1) RAM 45 [4], Bt LAFE 5 /1 45 & — Bt>=4KByte [f] RAM
). 7EFH ) HEE RAM JTUR AL J, H-FLASHER 233t FLASH K3 T %] RAM START ADDRESS ~
(RAM START ADDRESS + 4K — 1)[{JJulH N . FLASH ZXzh Al L R %% A ) SRAM 20 /& i 4h SDRAM.
WHRHARRSGH YN SRAM,  AEBUH A SRAM, AR F P SRAM 138 LEAM 3 SDRAM .
TEVCEVIIEA A B I, AL 75 BIWILA LI AS, XAt RG AT VI, DRI P 4852 1 RAM
AL ] DA IR U 1) 1)

(4) XTAL
KA S, H-FLASHER 75 2 400E H br R G /ME IR AR . FLASH IXah2 P8 FH P e e i)
XTAL SR RGP AT S, DRI AP A SR, fEi% e FLASH O A 85 5, Wil XTAL X
NI g AE AL T2ERPIRZS, MWL T 22/ P ¥ 22 XTAL.

(5) INIT TCK 1 PGM TCK
INIT TCK 1 PGM TCK 43 A48 5E T HIAHAIA RS FH 1) TCK A F a4 S i B A FH ) TCK A, 7k
X H bR RAEPATVIIACZ 1T, HARRGSCFFN TCK SR Al i tLR. £EXT H AR RS AT IR LA, (51
WIELE T RG0ED), HFRRSG LI F s m ) TCK . X kL F s T LAFE 5 76 A [ B B A 1)
TCK A%, ik H-FLASHER 7EAI A4 BT AR INIT TCK,  LUBA)5¢ el i A 4. 7EXT FLASH
BEATEAER R R, AR 1) PGM TCK, DLk 21 58 U (g i

+ HFE:
INIT TCK F1 PGM TCK ¥ Ftf H-JTAG USB /i St# A &L, - H LA AERIBHRE T 2 4 TCK A% (1
A2

5.2.3 Init Script

TEASBIES D, P BRI LA, PR F bR RACHATRIRIL. HFLASHER &1 14T
WIASRIEEET T, TP T LA IRUBBR A, SERTAIEFFHEIT . T R PTLAG R A G IR, 7
. KT WAOIA RS RS, 55 AT

PR FLASH 15, — AT 2R P 3 by a I A . 1) Fr 7 FLASH, — i 22 32t wih
A . WA A A ANMER: — R ERZEREN, X LLHIE ARM A FEAS IS /T8 2
B AR RS, LURIE H-FLASHER AT LLIEAA R0 FLASH B THE, [FIBABARIE FLASH 3K ) m]
PLIERf T 38 H AR 2451 SRAM/SDRAM H 2,

WA A B 2] FLASH RE0E S RERL) F 4. WA H-FLASHER $27~%51%: Can’t download
driver to specified address, A7 HL A& P A IRV IIAS, BURVIGAILIAAIE . ZEER4E
IEMIRTAE A IAS, BRI HAR RG A — 0 7. R UUT A7 40 B 5 H AR O 8 I 0, 42
AEAE T BB 57 o

+ o
EAE T H-OTAG 5 B2 I, & THEEERE, @0 J N R GE P B A, X k] LA R4
= TCK IS4 il FLASH %25 i 3F .
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5.2.4 Programming

LEXAL IR, H P 0] DU FLASH (5 00T U FHRE: A2 FLASH K H bR REHIEAE B
X FLASH BEATHEE, #ER, IR A FLASH & 154 75,

(1) Reset
XAMEAE AT LU H AR REPAT RG E AL B S22 0 A 07 St 7 R B AL 5 .

(2) Check
RXANERAE T LB E H AR 2R S8 L H) FLASH (1 1D Sz AR PHES B A JEL o 1T T LA Check T RER A
I RGBT IR, B H AR R GERIE B IR

(3) UnProtect
IXANEAE RT DU R AR5 ok 1 FLASH. @i SR H P Ik FE 1 FLASH ANSCRZ 8, XA S8 53l
4, H RS ERZEEY FLASH 5 STM32F CORTEX-M3 %71 F ) FLASH.

(4) Program
H-FLASHER #24t 7 =Fbe'5 J7 st H] 7 ¥ £ Auto Flash Download, Intel HEX Format, 1 Plain Binary
Format. fEKES I, Je's IR FE 7 R0 H 16 kb #02 DA AR 1K o 3 = F oy =X g il — X ) 4E FIX
L6455 B HLERAS

A - Auto Flash Download
K HIXF T A%, F P AT B8 2 Y5 SR H il . RS BB Fse S5 1) H sk #52
i H-JTAG $£4/t4% H-FLASHER [¥].

B - Intel HEX Format
K HEX SCHEAR G A E T Hhb R S BTEL, B Fh e A s, FH P A B4R %2 HEX X
PRI %A%, AN LS B 5D 0 H itk . H-FLASHER 2> A Zh M HEX SCAE R B k(= 6 .

C - Plain Binary Format
Binary SCAFA G A SR TR ANERTIEAE B P, PR U i, I
it B[] I iR —BER SO R AR AR B H A3k

(5) Verify
AN ERAE T L RIGAIEGE 5 /2 77 R4, Verify BRAE20RkE FLASH (N Ik, SR 5 AT 7 47 7€ 3
PEREAT HLAER. DA & e 2 17 L.

(6) Erase & Check Blank
FH PR LA FLASH BEAT 4R FIAS Y FLASH A& 15 0 25 o FE AT X PN EAE I, FH P mT DAIE $E 5 4
P FLASH $UUTHE/E, Bl FROM 5 TO N HEZE B85 it skl 3 [ o

(7) Read
H-Flasher i 32 (it T B2 IAE, 1 LLBRIRAR il 2R 48 1O N A5 TR A7 BT SEA L
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5.2.5 Program Options

H-FLASHER 241t 7483 eI, Bl A, —IXRAENINE . XD B, 17T DR

i F Q7 EE AT R NG T3 NIE T AR A

+

RESET
IR PEZIET, H-FLASHER BAERES 5eiin, BAL RS HEr.

VERIFICATION
R RE T ZE T, H-FLASHER B/ERE S 5C 5, # FLASH B e nsk, Rike s SCA-HE T X6}
b, = AR .

SKIP ID CHECK
AL FLASH it 1 17 1D 7] G2 Bl B AF A IR S5m A 284k, P a] DL I IX AN 3 ok 4% ) FLASH 1D
BIRS T . ISRk $E 7%k, H-FLASHER ¥kt FLASH ID [R5 2.

ERASE CHIP
— DGR, H-FLASHER fE e dbit # b S B R A2 R 52 W ) SECTOR. i Rk £ 1 %%k 1,
H-FLASHER ¥ EHATHE S HT, $ATHE A BB .

SMART MODE

WIS T iZIE T, H-FLASHER 7E45% FLASH 1, 2% FLASH H 52 S 5200 1R 358 or B s 45 s B O FAf
178K, fERSHIRHE, FHKE S FLASH 1k, @il SMART MODE, mJUMRIF/ERES 5ei)n, B
TR SO 2 A E], FLASH N e % 1) IR R AN 2 3%

NXP LPC1700/2000

X LPC R4 ARM (5K, [n) 53 PSR FI A 0 v NI BOOT #2277 AW FLASH W i H J 725
SEMAA IR . XANETA R IR S IR, 27 ik H-FLASHER W ) R MR . BRIA
THOUR, AshRRERes SOk, WM AR H-FLASHER i3 n) 3K, 75 RE %L

ATMEL AT91SAM
AT AR FIERE S 5e Un, 215 B E ATOISAM (57 I INE A, LLOR 7 AR

ST STM32F
AT RIS e, AT STM32F (5 A I RDP 545,  LARY I I FET

NAND FLASH %55 %15

NAND FLASH (585 thi R 55 2%, % NAND FLASH #E47685, 1/ T35 € RHIRME E.

v' Programming Mode:
1%+ NAND FLASH {5548, SKIP #:if /& RELOCATOIN Fat

v" Scan of Bad Blocks:
2 {E RELOCATION S5 HT, Wi, S8R FLASH, 162 R 2 H 2
Ik, {5541 Relocation [X I8 FI{# B4 [#) User Table [X i ;
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v" Reserved Area for Relocation:
FH 7 852 K Relocation X 4. W1 RGeS e, AERIIRER, £EH] 745 %€ 1) Relocation [X 15
S HREE IR, BT, RS

v" Reserved Area for User Table:
i %€ FH 7 ISk A7 i Relocation Table 55 45 & X 355

H-FLASHER 37 F 2 Flgg 5. 25— /& Skip bad block and jump to next one. % —Fl/& Relocate bad
block to reserved area. 7t SKIP 5T, IR {ERES Rl B, H-FLASHER Bk 411
SRge, N RS S BN — ANk 2. RELOCATE #8545, H-FLASHER 235G 1 1 42
PEAME R, BEEREE R FLASH, BUE KRR T 20 B3k, fddpe s F 24 FH i3k, H 48 € 1Y) Reserved
Area for Relocation [X 15 fil Reserved Area For User Table X1, i #5#1F, H-FLASHER ] L3R
KT NAND FLASH 5 F ISR EAE B e fEbe sl iy, an Rmlk 23R8, H-FLASHER 2371 Reserved Area
for Relocation X 45 H 48 2= 55— AN n] LS R 4 i, JPf JRUA B0 5 31 Y i IR e b 1 B e 5 3175 4
P e, [AINHE SR PR R . EREEUE, H-FLASHER 23k EUIR B f5 SR k(5 BAL
%45 NAND FLASH 3K5#5 /¥ . 7E NAND FLASH 3k #1#2)7 1) nand_info_table() ki %5, FH /= ] AR
SRELAE R, IS A S sEhrsk, 4 NAND FLASH [f) Reserved Area for User Table [X 1 & 37 [
ORISRk

+ FE1:
£a'55 NAND FLASH F g, 5 ik £6 1) 52 SKIP X, H-FLASHER {E52be s fin, Aoxsy
FLASH X sl F P AR IR IR R R R 85 & . 1A RELOCATE #i:0F, H-FLASHER A4 &7Ekes
SEJE, 2 FLASH IRSHFE 7 AR R BRI e e (5 B

+ HEE2:
FHXE NOR FLASH Fi1 7 FLASH fIBE 115, NAND FLASH (155 ELA S 24 . an 1] ) s A
Fl RELOCATE 85 #55, 1EMRE [ O 75 2L, (U MY 1) FLASH SR F2)7H 1) nand_info_table()
PR, DAL A SEBR T B SRR R e .

+ HEE3:
AL U AR A3 R BN AE . 72 A3 M AR, H-Flasher 7 RIS IX LEE T .

4+ PRODUCTION MODE
A EITIRE R SR WREFAZIEI, Al ae A meae A B0, B IR
NN AR D IRIEAR R b, DR AR . MEANABUG, H-FLASHER B3 ke s H
bRo AERENEI HARE, HTHAEES . SEEM0n, Rl WomER. T A TETHRIN N e
UFRES HbR, AERESSER0R, KBS HARWIT, SRJGHHE T D ERE 1 H b RGER S
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5.3 ¥ LR

+

BoR-1:
H-FLASHER fl H-FLASHER LITE &4 & —FER, ME— X 5))E, H-FLASHER LITE A3 £ AUTO

—

FLASH DOWNLOAD. 1] " 7% 3] AUTO FLASH DOWNLOAD, iffiafT ffl & H-FLASHER.

BoR-2:
FEVEE IS, G R A AMESOE N RAE S K GBS AT gm0, UL U A — ANk,
ANTEEH HRIE

HIR-3:
EH P BC A SN RS, P el LU G B R AF A HFC SCfF. 7T RImi%, wTLLYE H-FLASHER
T HFC SO, 48 26 T R RS B 1R BRI

on-4:
HE'EHI, H-FLASHER £ HahPT L E B ERE . FTUUH P AT BAER ST FLASH {85 $47#
.

#IR-5:
FLASH #EBRERIEHZ LIER (Sector) Jydg/NAL I, —ANEREIKNEF AL KT —A BYTE. A T
B K, H-FLASHER 241 T 1 3 2% 4 A1k Z LTI (SMART MODE) . fEHAT#2FRHT, H-FLASHER
SR BE, FEERES Bk B R R IX T B . LI AL, ] DURE ke s X S A R B e
Bs

#IR-6:

BN, W & B R Destination flash address is out of range, 5 B F1 /45 & 19 H i Hb
HEANTE FLASH A RV A, sl HEX SCPF R U ik ANYE FLASH B0 80t bl YE N 1
P ks A bk 5B R T IR, BUE HEX SO b2 157 1R

BR-7:
HE FLASH 5, BEEFRA ML, O H ID A TRES o, W RILXFEDL, 15 H P F3RAT]
PR, BATSIRMUH FLASH IXahfE 7.

#oR-8:
TR FLASH BEATHAE R I B A, 1A A0 & 25 E A WA S A, (His 2 PR, 1
FATECR, AV S 007 @ B AR . B, FATSHME FLASH RS 7 R8N FLASH 4%
HIKE),
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5.4 BEESZH] 1 - AT91ISAMT7X256

AT91SAM7X256 /& ATMEL 2w it —# 5T ARM7 5 Fr o %0 i T 256KByte f) F 4 FLASH.
NHFRA VA AR H-FLASHER ()42 7] 5 Wil R e & R4S ATIISAMT7X256.

5.4.1 Flash Selection

PRI RS0 ah, SRS . XA, RN AT9ISAMTX256, W1k B i
&| H-Flasher =101

Mew Load Save Saveds Options Ewxit  About

Program Wizard >> Flash Select

Flash Selection

1 - AT SAM ;I Wendaor: ATS15AM
2 Configuration L ATIISAMTAS
Partho: ATH154M 72506
3 Init Serits - ATHISAM7S123 s
] - ATIISAMTSTE Type:  OM-CHIP FLASH
' Frogramming - ATSISAMTSE]
) Sector: 1024
5 Pgm Options - B TI1SAMTS 256
» General - ATH54MTE32 Block:  N./&
- ATHSAMTS 32
» On-Chip Flash - ATHISAMTSET2 Page:  MN/&
# Mand Flash - AT 54MTSE4 Size:  256KB
- ATHSAMTSEZEE
2 H-Flasher Help o ATHISAMTSED? 1D: 0x275B0940
- ATISAMTSES2 “Width:  32-BIT
- ATOTSEMTE51 2
- ATHSAMTACT 28
- AT SAMTRC256
- ATHSAMTRCE2
e ATETCARTET 70 d

K| 5-2 4 AT9ISAMT7X256
5.4.2 Configuration

TEM SR 0, XA ATICE . OB S 2 ATILSAMT7X256 19 /7 FLASH, fi HAX B8 Fr
I 58 FLASH AR AR HIMEFT RAM L af thhk #2119, Bl DU AR B AT w8, SR AT ERA (i st mT A
T o P WATRESR @ IMT IR IE . WE WS EPR:

& H-Flasher {0 ] [

Mew Load Save Sawveds Optionz Exit  About

Program Wizard

1 Flash Selection
e T A .~
Flash Wwidth = Chip: ‘ 32EBit» 1-Chip >

3 Init Scripts

% Programming Flazh Start Address:

|

5 Pgm Options

» General Rt Start Address: 0=200000

» On-Chip Flash
# Mand Flash

Ext=TAL [MHz):

? H-Flasher Help
IMIT TCK:

G I TR

i

K 5-3 BLERE
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5.4.3 Init Script

R SRS = Dd, RWEWGAEA. BohES M AT9ISAM7X256 1] W FLASH, T H
ATI1SAMT7X256 [IHE"5 IK ) 2 Hh EL2e ARG T WIURALER 5, BT AN T 2 P 3R AW AL AN o 22 X PP s 0 S
JEVAS G i (1) e il A 2 AR FH I i R LT

(B n-rasher =10l x]

Mew Load Saveds Option: Esit  About

Program Wizard >> Init Scripts - AT9

Flash Selection -
Id | Crod [ width | Address | Walue ]

Configuration

Init Scripks

Pgm Options

1

H

3

Y Programming
5

» General

» On-Chip Flash
» Mand Flash

3 H-Flasher Help

« 3 B

Kl 5-4 BCEAIIRIINA
5.4.4 Program Options

TETFAERT FLASH BEATH/ERT, H P AT LAYE PGM OPTIONS P ERHIEREA R g R i, /e L, 3K
MTEHE THAERE S G AT RGEEAL, IFAT —IKBE, W R B s

=0l x|

Mew Load Save Saveds Option: Exit  About

Program Wizard >> Pgm Options - 4

F H-Flasher Help

1 Flash Selection RESET

2 Configuration eset the target after programming has been completed.
3 Init Scripts VERIFICATION

¥ Programming erform second verification by reading after programming.
5 Pgm Options SKIP ID CHECK.

» General [ Skip the check of flash id before all the flash operations.
¥ On-Chip Flash EBASE CHIP

» Mand Flash

™ Erase entire chip instead of sectors before programming.

SMaRT MODE
[~ Backup flash data before erasing, and then restore them
during programming.

ADDNON
™| Eriabke hiflasher add an

Kl 5-5 Zi FELL I
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5.4.5 Programming

ERCE L G, (Egnfein S Programming H, HtAT LX) FLASH $ATANREIHEEE T 58, ATk —
X CHECK #fF. it CHECK #:4F, F nl LLCRS I Wy i 158 B 2 5 IE M . AEA9 T, CHECK HI4h
& 5-6 Fros. HEF ERiE ST LUE H, /i R E S E A .

=| H-Flasher

1
(=]

x|

Mew Load Save Saweds Options Exit  About

Program Wizard >> Programming - ATQ

=10l
1 Flash Selection Flashi " ATI1SAM7H256 0x275E0340 Reset
& Configuration Target™~~—ARM7TOMI Little-Endian Check
3 Init Scripts :
z Security: WnPratect
% Programming
5 Pgm Options
» General Type: IAuto Flazh Download j Program
¥ On-Chip Flash Dist Addr: I j Werify
» Mand Flash Eaa I j
2 H-Flasher Help
Fram: IEntire Chip j Erase
To: IEntire Chip j Blank
Address: | O Read
Sizer I

] 5-6 CHECK #:1E45 )

FEHREES — A RIS FEAEI T, SRRSO O ], YESCHEh C\TEST.bin, 5 HH
fthhl ok 0x0  (FLASH jitigthhl), wE WK 5-7 s, WE G, siidi PROGRAM # T URBES . ke
YT, AP SG BRSSO, PRSI, Yar g E R RS %EME, H-FLASHER
SPORFEE IR KT, W 5-8 .

= H-Flasher

1
=

x

Mew Load Save Saweds Option: Exit  About

Program Wizard »» Programming - ATQ
1 Flash Selection Flazh: AT SAM 7256 0x275B0340 Rezet

2 Configuration

3 Init Scripts :
Security:

% Programming /‘_'_'_‘\

5 Pgm Options

Target: ARMZTDMI Little-Endian Check

WnPratect

AR T,

» General Type: IF'Iain Binary Format Frogram
» On-Chip Flash Dzt Add IFIash Base Address Werify
» Mand Flash Stc File:  NCATEST bin
2 H-Flasher Help
e S—
From: IEntire Chip Erase
To: IEntire Chip Blank
Address: | O Read
Sizer I

K 5-7 REXRE
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= H-Flasher P ] B
Mew Load Save Saweds Option: Exit  About

Program Wizard >> Programming - AT91

1 Flash Selection Flash: ATHSAMTX256 0x275B0340 Reset

2 Configuration Taiget  ARM7TOMI Littie-Endian Check

3 Init Scripts Ser

ecuny:

5 Pgm Options

b General Pragrammed and Yerified »2 successfully. M

> onchiprah | — Veiiy

» Hand Flash A0KB/s + 512KB/As Size = 256 KE | |,

2 H-Flasher Help

M Eraze |

To: IEntire Chip j Blank

Ll

Address: | 0 Read

Size: I

5-8 FE'H 5Tk

5.4.6 RIFRE

a7 LS H-FLASHER [¥) SAVE i, K LI s & AR A7 HFC BCE Sk, fELUSEH . 7L
JarE s, AT DL R H-FLASHER HURE3% HFC S0F, 49 2 1 RRIRERS L JRIEA T 3¢ B 1 R K o
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5.5 BB 2 - LPC2210 + SST39VF1601

LPC2210 /& NXP A (if PHILIPS -544) [J—3K ARM7 ‘{5 7. %57 16KB 1 N SRAM, {H
AT AW FLASH. Z5 A 4 AN MEMORY BANK,  A] I Sk9™ g4 FLASH Fl4h i SDRAM. 7
A, {3 BANKO I kJ 4 FLASH, %45 % SST39VF1601, BANKO (¥ i bt i 4 -
0x80000000~0x80FFFFFF ; BANK1 H] >k ¥ J& 4 & SDRAM , BANK1 [f] Hu hk 5 F 4 -
0x81000000~0x81FFFFFF, I [ FRA 14 A 24 anfr] % LPC2210+SST39VF1601 #ATHE'S -

5.5.1 Flash Selection

FER SRR —D M, SRS . XA T4, AT EERN A SST39VF1601, Wi &

AN
=| H-Flasher P ] B
Mew Load Save Saveds Options Exit  About
Program Wizard
Ao - S5T3ALFOBD =] Vendor 55T
2 Configuration . 55T39LF160
PartNo: SST33F1601
3 Init Scripts - S5T39LF 2008
) - §5T39LF4004 Type:  MOR FLASH
% Programming - §5T39LF512
: Sectar. 512
5 Pgm Options - SST39LFE004
» General - S5TI95F0104 Block:  Mi4
- §5T395F0204
» On-Chip Flash - G5TI95F040 Page: M4
» Mand Flash - SST39FOT0 Size:  2MB
- SETIFWFO20
2 He .
2 H-Flasher Help - ST IVEO 10 0x234B00BF
- S5T39WFO80 Wwidth:  16-BIT
- SETIFVFOS3
£l
. § TG
- SETINF16E1
- S5T39WF1682
. CET ICAEINNA j
¥ 5-9 LL+E SST39VF1601
5.5.2 Configuration

TE SRS 0, WAEEIATICE . SST39VF1601 H S kF 16-BIT #ix, FTLAA % R ERIA B &
FLASH /2 7F|H BANKO ¥ &), 1l BANKO [z afhit & 0x80000000, FirLh FLASH (¥ 4f itk B i% /&
0x80000000, fE45E RAM “F [al ¥y iz, FRATH AT H ) SRAM B2 4 SDRAM, a4, Fedi ik
P44 SDRAM . 4 SDRAM S 4] BANKL §fEff, 17 BANKL [ 4k & 0x81000000, FtLL
RAM [FC i Rk v DLk 0x81000000. EIXAME 1L, F AT Z4R 2 /MT R AR . &Mk E
1% 5-10 7
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= H-Flasher I :: ;Iglll

Mew Load Save Saveds Options Exit  About

Program Wizard

1 Flash Selection
e T T~
Flazh ‘width = Chip: ‘ 32-Bit 2 1-Chip i

3 Init Scripts

\/

% Programming Flash Start Address:

0

5 Pgm Options

» General RAk Start Address: 0=200000

¥ On-Chip Flash

» Mand Flash Eut =XTAL [MHz):

2 H-Flasher Help
IMIT TCK:

oo 0w D

[l

5-10 AL E K E
5.5.3 Init Script

4 LPC2210 M4l F M, FATHR ZXN = A F AR UEIT R E . PINSEL2@0XE002C014, BCFGO
@OXFFE00000 1 BCFG1@O0XFFE00004 . FLr PINSEL2 A& % Ik 4 hll 25 47 2% » HH LB 2 2 HH A5 IR 1 g
5t M ik 22 R S 45 5 5 . 17 BCFGx M2 % BANKO A BANKL #HATHCE , 1 LAY B 195 2545 531, 4k
Pl 5. A RAMAOE X, 152 LPC2210 M F M. oA, FRATFEZEE 3 £HIA A, R
A B s

& H-Flasher e =101 x|

Mew Load Save Saweds Option: Exit  About

Program YWizard >> Init Scripts - SS

1 Flash Selection -

Id¢ | Cond— [ Width | Address [Vame—— |
v SetMem  32Bit (WEDOZCOT4  OWOFS14914
(2 seem  32BH  OFFE0ODDD  OwI00OTDET
Setem 328t  O«FFE0OO04  0x10000400

2 Configuration

Init Scripks

Y Programming
5 Pgm Options
» General

¥ On-Chip Flash
» Mand Flash
2 H-Flasher Help

« 3 9

5-11 B E WA ILIIA
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5.5.4 Program Options

TETFAERT FLASH BEATH/ERT, H P AT LAYE PGM OPTIONS P ERHIEREA R g fE e . /e L, &
AT TAERE S o AT RG B AL, FFAT —IKKE, G R & s

=| H-Flasher P ] B3|

Mew Load Save Saveds Options Exit  About

Program Wizard

1 Flash Selection RESET

2 Configuration eset the target after programming has been completed.
3 Init Scripts WVERIFICATION

Y Programming ‘erform second verification by reading after programming.
5 Pgm Options SKIP ID CHECK

General ™ Skip the check of flash id before all the flash operations.
» On-Chip Flash

ERASE CHIP
» Mand Flash ™ Erase entire chip instead of sectors before programming.
‘2 H-Flasher Help ShART MODE

[~ Backup flash data before erasing, and then restore them
during programming.

ADD O
= Enabke hiflasher add on

Fig 5-12 &k
5.5.5 Programming

ERCEL G, ARSI PROGRAMMING H, #lrl LLXf FLASH $UATANFEIEAE T . ok, o]
DL —ik CHECK #ff. 1lik CHECK #4F, F ™ vl LACHE AT iy 1 19 6 B e 5 156 . fEAFIH, CHECK
F & R R B BT B s iAE ST CLURIRT, T v B IR

= H-Flasher

ol xl

Mew Load Save Saveds Options Ewxit  About

g
Program Wizard
1 Flash Selection Reset
2 Configuration T =
3 Init Scripts o
ecurity:
Pragramming M
5 Pgm Options
b Gereral Tupe: IAuto Flash Download j Program
¥ On-Chip Flash Dist Addr: I j Werify
» Mand Flash e I j
3 H-Flasher Help
Framm: IEntire Chip j Eraze
To: IEntire Chip d Blank.
Address: I 0 Read
Size: |

5-13 CHECK #:/E45 5t
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FHEEARE S — A RIS AEAEI T, RSSO k], RSO CATEST.bin, K5 H
il >k 080000000 (FLASH i dfiiiiik), & & 4nld 5-14 FioR. BEE TG, ridi PROGRAM # 4 TF4A5EE .
PSR, 5 SE BB E SCHFON, PGS, Tk B . S 585 , H-FLASHER
PR EIFIRAE ST, R 5-15 .

55.6 R RE

=| H-Flasher

Mew Load Save Saveds

1
=]

Options  Exit  About

x|

Program Wizard

1 Flash Selection

2 Configuration
3 Init Scripts

% Programming
5 Pgm Options
» General

¥ On-Chip Flash
» Mand Flash
2 H-Flasher Help

>> Programming -

Flazh: SST3VF1601 0x234B00BF Reset
Target: ARMZTDMI-S LITTLE-ENDIAN Check
Security: /--""'_'_'_""'--..._\ UnPratect

/

IF'Iain Binary Format

Program

e
|
|

RIS

[rat Add IFIash Base Address Werify
Sic File: CATEST.BIN -

) ]
From: IEntire Chip j Eraze
To: IEntire Chip j Blank
Address: | O Read
Size: I

& H-Flasher

Mew Load Save Sawvehs

5-14 5 HE

1
=]

Options  Exit  About

X

Program Wizard

Flash Selection
Configuration

Init Scripks

>> Programming - SST39VF

Flagh: SSTAMFIED 0x234BO0BF Reset
Target: ARMTTDMI-S LITTLE-ENDIAN Check

WrFraotect

Pgm Options
General
On-Chip Flash
Mand Flash

E_

1

]

3 -
Y Programming H-Flasher

5

-

-

-

Programmed and Yerified %2 successfully. Program

Werify
110KB/s + 122KB/s Size =2 MB

3 H-Flasher Help

Cloge

B [ | [l e Y ¢

Eraze

T —
To IEntire Chip - BElark
Address: I ] Read

Size: I

5-15 K558k

QIR B8, R AT DO R E A o HFC BB SO, (LU AER . A2 RS R AE T
A LB #:4E H-FLASHER 53545 HFC U1t
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FNE HIIHALIA

XTI R A H-ITAG € XIVIIGALIEA, R aa R ] H-JTAG/H-FLASHER 1) I A< g 45
ML,

6.1 HIEHALBIA I 5E X

H-JTAG S 3t LT 6 WA LA Setmem, Getmem, Delay, SysReset, SoftReset Fll SetPPMR, 1L
YER 23 2 B WAF A, LA IME, BINAER, $UTREEAL, PATHRE AR E ARMLL ) CP15
Peripheral Port Memory Remap Register, W13 6-1 fz~. H7 o] RS B QR EE, Al AT 2 0 A 41 & %6
RGATYIIRA .

*® 6-1 WAL A

WAL A JAIAAEH

Setmem WE WA AR IE

Getmem TLIA AFE

Delay NS

SysReset PATRG AL

SoftReset PAT I AL

SetPPMR B'E ARM1L ] CP15 Peripheral Port Memory Remap Register

£ R
H-JTAG H i - & 3C T LA R IA &, X 28y T LU L K 7K. H H-JTAG & (4]
AL IIAAT W] e 2 MR AT S RO B PR 7 B 7 78
NI GEA LA AR R 5

6.1.1 Setmem

Setmem Sz gz 5 F I IIAS o FFHIXANEIAS, FH 7 a] DLk B N A7 502 75 A7 g (0AE, I BLSE R A IR 1L .
Setmem 1) H fA4% 2 2«

Setmem 7 G4 HerfE.

B Setmem — AL

LI VA — RONEWEMHPMERAI Y, WERAL %A 8-Bit/16-Bit/32-Bit;

B OHhEE — RORIEERER H L, B I AR B A D R MR 6 55 15
B HARE — M AES R H R, T I R PR B A 5 i N I M s
il

Setmem 08-Bit 0x0 0x12 — ¥k ox0 MIfE 3R 0x12, f7%8% 8-Bit

Setmem 16-Bit 0x0 0x1234 — FeHhhl Ox0 (E A 0x1234, {7 %4 16-Bit

Setmem 32-Bit Ox0 0x12345678  — ¥4#idi- Ox0 HI{H i% A 0x12345678, 4% K 32-Bit
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6.1.2 Getmem

Getmem ] LR A7 B2 2 A7 4% (4R XA A A & 1 2O FIERF E &, B R &
AL R R RS Ik (1B Getmem fRJRL Ak U«

Getmem 7% H#pjthh) .

B Getmem — JARSA
L IV — RN HARME R 55, ATIERIA BE 4 8-Bit/16-Bit/32-Bit;
[ IRENEORERi — RONMGEERER H bRl 5 A TS AR B A B SRR Mk 6 SR
%15
Getmem 08-Bit 0x0 — BeHUhE 0x0 [R{E, 1796 K 8-Bit
Getmem 16-Bit 0x0 — BEHUBHE OO HOME, 7% 4 16-Bit
Getmem 32-Bit 0x0 — BEHUBHE OO HOME, 7% 4 32-Bit
6.1.3 Delay

Delay 7] LA RASINGELR o FEHAT IR, A7 I AT 6 BAEPAT 58 — 56302 ), S5 fs— 2 IR
], FEPAT ST A . XM O, P T LMEEH] Delay A 4. Delay f9R Ak A -

Delay ZERfH (H#fr: ZE7)

B Delay — WA A4

B EIR{E — REIBPYIFE], AR
155

Delay 100 — 43R 100 2=

6.1.4 SysReset

SysReset ] LLAIRIAT R R AL IXAN & AT URAESIT AR A7 B, FORAESATRIAR AL 2 Fixt H AR &
GAHAT RS NLARAE

+ TER: SysReset Ay A HAEME A S —MHAG A, WURXA A ML e E L, Rk 2.
SysReset [ EL A A A 2
SysReset (RAHLEITZH)

B SysReset — BAmS
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6.1.5 SoftReset

SoftReset 1] LLAIKRPAT R E AL . 1R #RAE F BRIk E A CP15 ¥l 77 f7ds, HLLCH] CACHE, %%
MMU 4§, S3C2410 /& 21—k T ARMOI20T .85 F, SZHF MMU. 7E LINUX %8% 2] S3C2410 )5,
LINUX < HAIECE MMU, #7540 REMAP #:4E. i MBS FLASH, SIFEWIIG A
[FFL N SoftReset #ir4, IXFERT LA CACHE FIZEH MMU, fR4IE H bk R HIAE A2 BT R 1
SoftReset [ 2 A4S A2

SoftReset (BHFITZ4)
B SoftReset — HAGS
6.1.6 SetPPMR

SetPPMR 1 LI 2K ¥ & ARMI11 [¥] CP15 Peripheral Port Memory Remap Register. SetPPMR [ 2 A4 24,

IT
SetPPMR  ARM11 CP15 PPMR & /7484%

B SetPPMR — A4
B ARMI11 CP15 PPMR 3172841 ;

%15
SetPPMR 0x70000013 — ¥ PPMR 27 {745 F{E 5 & 4 0x70000013
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6.2 HIEHALBIAS ) St

H-JTAG Fil H-FLASHER # &4t T A gmi a4, 7 (0 H 7 A . H-JTAG Fil H-FLASHER [ JHIA 9w
SO B4 S0 1) 6-1 F & 6-2 . H-JTAG il H-FLASHER [ 4m#8 24 - —FEN, 76 RIHIA- A, %A1
BEAIX 53

H H-ITAG Server o ] |
: File Control Flasher Init Tools Settings Cptions  Help
BP9 Init Script
Ids | Cmd | width | Address | Value ]
+*
éa
»
¥
[~ Enable &uta Ikt Mew | Load | 0K | Eancel|
Ready [ [ [TCk=1.0m  |UsE
6-1 H-JTAG 1A g4 2%
[ 11

Mew Load Save Saveds: DOption: Exit  About

Idx | Crnd | Width I Address | Value I
Canfiguration -
| |

Init Seripts

Flazh 5 election

Programring

General
On-Chip Flazh
Mand Flazh

Production

«r e

1
g
3
Y
5 Pgm Options
[ ]
-
-
-
B

H-Flazher Help

6-2 H-FLASHER Jil A< 2 i 4
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6.2.1 WA

FEMIA G ds b, R0 T 4 DERIEEL, 2 ARSI, MR ERATR R, Ak SCarh .

i+ B AL R A 4 10 _ERE B

+ @ ININ—ASHT R A iy 4

+ » T 5% 224 W8 % ) JRA 1 2>

+ ¥ B ATE R A G 2 10 R 8
6.2.2 YRiEEIA

XPRFAHTIAAS, HI e BOCI R AS i &, SRR MR 2 SR B Z IS B B — 0BT IAS, 78
il o SRS e 117 R 7S I 9 1 1 S S P U N SN

>> Init Script

Idz | Crmn i
[«

“« 3 4+

6-3 VST IHA

st AR Cmd %1, H]J ?JETUE%U&HT@WTTE’JH*MK a2 AN . AL AT DU A 2R iy 2

width | Address | alue ]

Delay
Gethdem
Settdem
SetPPMA
SysReset
SoftReset

« 3 & »

6-4 A AR
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AR L FE 2 SysReset fir 4, MRPEE X, HI AT ZAERR I 115 8. SysReset iy B B 5 A »
W E PR

>> Init Scripts

« %+ »

K 6-5 ¥ & SysReset JHIA
TR Pk $E 1002 SoftReset fir 4, AR & S, FH AN TR ZEAEIRAIL A1 240 . SoftReset iy 4 & 58 15,

W B R
>> Init Seript__—

Idx | Cmd \Width | Addiess WValue

« 5

Kl 6-6 ¥ 'E SoftReset A<
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WA LS T Delay 4, HRAE Delay fir&[¥15E X, HIJ7 524 Value 71 U A Y12 AR SEIR 1N [4) o
Delay T & B E5EHUA, W F K Fs:

>> Init Script |

“« 3 4+

6-7 ¥ & Delay A

MR IERE T Setmem iy4, MR Setmem a2 H1E X, WP FEREL S, HIMEER HARE. X
T Setmem x4, il Width %1, W RAIEREA 56, W1l 6-8 Fian. EEEIFA vE G, 7 W5 54E Address 1) Al
Value %143 33BN H [ bk A H FRE. Setmem 415 & 52 5% Wi 6-9 k.

>> Init Script |

I | Crod width [[address | Value |
1 Setmem 'I
D5t
16-Eit
326t

“« 3 4+

6-8 LEHEAL T

>> Init Script |

“« 3 4+

& 6-9 & Setmem JEIA
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WM IERE T Getmem 174, H 4 Getmem iy 210 5€ X, H 7 75 ZL B A7 56 A H R stuhk . %5 T Getmem
i, i Width 81, mRLERA T8, A1l 6-10 Fras. EFRIFA 58 )G, P 75 EE Address B3 B RAE
B H B hE. Getmem iy 4 1 & 58 G Wi 6-11 ATz o

>> Init Scripts

Ide [ Cmd [ width [Addiess | Wale |
1 Gethdem IDS-B 'I

« 3 &

K| 6-10 LHEAr 5

>> Init Scripts

« 3 &

K 6-11 & Getmem A<

R EFE T SetPPMR v, HAE SetPPMR fir & H5E X, F) 75 2 4E Value 41 5 N PPMR &7 47
ZRI(H. SetPPMR iy & W E 5eG, W FEFTR:

| SetPPMA Ox70000013

« 3 »

K 6-12 % E SetPPMR A<
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6.2.3 ¥SINEIA R

AR g s 5, F 7 ] LSRN A Gy SR I e . 7E A g ge b, AU A6y 4 BT 6 IDX,
L ANEREAHEHE, & 6-13 A JH AT DU Rk 3 AN G HE HL 2 n S R I A B . B S
AR, s UPDATE. WISRATFEMS N, 7L E#E A CANCEL.

>> Init Scripts

Ids | Crmd | width | Address | Value ]
1 Setrem  32Bit  0«10000000  O¢12345678

Script Comment

Comment

« 3+ »

Update Cancel

K 6-13 AT R

USER MANUAL Copyright © 2010 WWW.HJTAG.COM All Rights Reserved 6-9



FLE R E

XA A

NN T AT C B T B R T (Debugger), BUE] H-ITAG SEAT R . A2/ 2 it 4k
FAFE: AXD. RVDS. IAR Fl KEIL, {EWE5EMIG, BRI IR T, & IEAIE A ik,
FIF HITAG, FHAI R H AR IR BRI, 152 2% AR A P F bt

7.1 AXD HIBCE

ADS 14 F5 /& ARM DEVELOPER SUIT, /& ARM A A i) ) IDE, #IHARZ KT ). 1fii AXD 5& ADS
H A KRS . N id & AXD PAC 4 H-JTAG #E47 T

5%, fidi Options -> Configure Target 328, & 7-1 fion.

File Search Processor Views System Views Execuke | Options  Window  Help
Eﬁ-lﬁﬁll EI !’vliﬂl &l mlml | Disassembly Mode 3 Iﬁmll_ |E||E|| |[

Target ||mage| Files I Clazs | Corfiqurs Inferface.
Configure Target. ..

=13l x]

————
L2y IQUrE FRECEssar, ..

Source Path...

w Status Bar

Profiling

Swyztem Output kMonitor
ROl Lag Debuglog
Log file:

RO Severe Ermar 00500: Could nat find hetag server. Please make sure that hitag server has been started properly.

1 |

i

|<:N|:u Pas> |_|_|::Nu:u Image Mame> 4

Configure karget and debugaging agent options.

7-1 Configure Target S
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ROk, P 2F 2K 7-2 frosir) Choose Target it & & 11 .
axp

File Seatch Drocaceas Miawe  Suckars Wiawe  Fvaciba  Onbone  Sindos Healn

| E 2

— Target Environments

Taiget | Im: | [Tager [For [ File [vesion | (]  add
Hemove |
Fename |
Save s |
Eanfigure |
Systern Outpl ) i )
r *  Pleaze zelect a target environment from the above list or add a target environment
RO Log \]\i) ta the lizt. Mote that a target environment haz to be configured at [2ast once before
Lo file: it can be uzed.
ROI Severe
[k | Cancel | Help |
| i
For Help, press FL |=Mo Pos = |_|_|{:|":JD Image Mame>x

7-2 Choose Target [ & % I]

E LEPORIMBCE & 1, S Add 24, S E/BE 7-3 Frosike DLL SCHEISTURHE . 76
W HE FLIEPE H-ITAG 2235 H & F i) H-JTAGDLL, #RJ5 fithiffie .

ax -1of |

FllE Search Dracacenr Wiawie  Suckam Wiawie . Fraciiba  Onbone WWindas Hals

| Choose Target ﬂﬁl
w | -
s open G
Target | ime | [ 7o = . A Add
Look in: | 2 HJTAG | & & e B
Hemove |
Hename |
Save bz |
Canfigure |
Systemn Outp
ROl Lag C 1
Lo file: " File name: |HdTﬂG.dII Open I
RDI Severe
Filez of type: IDLLS (.l j Cancel |
4
Ok | Cancel | Help |
1| ]
For Help, press F1 |=Mo Pos> |_|_|<:Nu:u Image Mame>

7-3 1EFf H-JTAGDLL
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WG, M)A LLE S HITAG &R s AXD B2: 7, K 7-4 s, {6 FEd, Mt H-JTAG 8%
At Configure #2481, st nl AR B W& 7-5 Fos ) HATAG {5 5. 7EK 7-4 1, fiidi OK, AXD HIRC
B AR T .

axp

File Seatch Drocaceas Miawe  Suckars Wiawe  Fvaciba  Onbone  Sindos Healn

B = Choose Target
| |

Target | Iz

— Target Environments

Syztem Outp
RDOlLog [
Lo file:

RDI Sewvere

H-ITAG Debug Interface for ARM [n-Circuit Emulation.

ok I Cancel | Help
4| i

For Help, press FL |::N|:u Paos= |_|_|{:ND Image Mame> 4
7-4 BE TR

about H-JTAG |

H-JTAG “er Mo [BUILD Date)

Hitp: v hitag. com
Hittp: 4 forun. hitag, com

Twentyone@hitag. com

Caopyright [C] Twentyone 2004-2008.

ok

7-5 H-JTAG 1 &
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7.2 RVDS KB E

RVDS 45/ REALVIEW DEVELOPER SUIT, /& ARM A #]J5) [ IDE. FIH#LL RVDS2.0 4
B, B E RVDS LUELS H-IJTAG #4711k . RVDS2.2 ML BERA A, (HIEA—FE.

W, fidi RvDS 35t L “Click to connect a target”, 1 K T n:

£ RYDEBUG [Unattached]

-File Edit Find Wiew Project Tools Debug Help

Ded|f2REa R tIAEal P - - DEEE

File: [BRO_SOURCE Find:l | Line: | |81 -

Not ¢ = r sScaope
ick to Conkect to a Targe
_-'-'-————_____————-'-__

1|I|\D3m},8rc.r' ﬂ

= Hane I'\Falue = Hame |Value
JI
ol| | I\ canstack fTocas £ < 0| || > Pwstent fwetenz fw o] o] |
[—
Hones
e eme (stao fevier fFiefind fsrectr fLog / 1 ¥|=]
For mare information, select Help from Menu [Lr 1, Cola [ [ | [ =
7-6 RVDS % [
Nk, MBI 7-7 it Connection Control Bt & %
.22 RYDEBUG [Unattached] -0l x|
Il Flz Edit Find ‘Wiew Project Tools Debug  Help
Ded s2RED PR +IACEl P -5 - D28,
File: ENO_SOURCE “ar Connection Control (twentyone'rydebug.brd) - |EI|5|
Not commected - no | r-H
Click to Connect to | Name |Description r Contexts ;I
EH% ARM-A4-FF ARM Ltd. RDI targets

S ARMulator APM instruction set simulator

Ml ti-ICE ARM JTAG debug interface (parallel po: ﬂ ﬂ;l
- @Remnte_& Angel debug protocol (serial porr)

Naue | Val E-Server Connection Broker
= # %% Localhast Simnlator Broker

o 4] v P ol stack fLace
= » connect,route 4 4| PI\CDnned ,{Synch}' 4| |ﬂ

¥ |7 Cconnect,route 4

‘I J
JEL»u Ion

None
ot P emet {stao fBuid fFieFind {srecn fLog / i
Search fior text in file [Lr 1, Cal1 [ [ |

7-7 Connection Control fit & % Il
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fE EEBCE R Db, g, ST DU Bl 7-8 s,

.2 RYDEBUG [Unattached]
-File Edit Find Wiew Project Tools Debug Help

D@ 2R 0D 0

File; ENO_SOURCE " Connection Control (twentyone' rydebug.brd) i =] |
Hot commested - no 1 TP E_ Ea
Click to Comnect to | Name | peseription r Contexts> ;I
[=H% ARM-A-FR ARM Ltd. RDI tardgets
ghRMulatur AFM instruction set simulator |
m i mlci- ICE B parallel po:

@Remute_&
Naue | Val E-Server
% localhost

41 [

j FIvI
al port) ﬁ
i

3
1| PI\CaII Stack £ Locs ;I
= > connect,route 4 1| F[\Cnnned ,{Synchf ‘I |ﬂ ;I
-

> Cconnect,route 4

| Nones b=l
Lt \omet {staio fBuid [FieFind {Sroct filog / 1! AR
Search far text in file [r 1, Colt [ [ | e

7-8 NN

7EK 7-8 s, k% Add/Remove/Edit Devices, #itr] LAE 241 K<) RDI Target List &
M,

' R¥DEBUG [Unattached]

0| &

L — 1 —  Uzethe check boxes to add or remaowe RDI targets from the connection manager:

File: I ho_soL Mame | Wersion | Dezcription |

NDF COMnest | (e Remaote A vl.2 Angel debug protocal [zeral port] T
Click ©o Cc | @4 MuliCE V22 ARM JTAG debug interface (parallel part) 2]
1M ARMulator vl.2 ARM instruction set simulator

E
:

Hame ‘l

|<|b|Br:au: d!

= > Cconnect Add DLL. .. ' Rezet list | Ennfigure...l Eemove | Duplicate...l ‘l

> COnnect

i Y
E"I k[t cm

Search For text in File [Ln 1, Cal 1 | | | [ 4
7-9 RDI Target List % I']

41 H

L
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R 7-9 F, $E Add DLL, Ji 74 F40n 7-10 Fras i) Select RDI DLL SCF % 1o AEXANE 1A,
Pt H-JTAG %35 H sk N H-JTAGDLL, )5 s

‘? RY¥YDEBUG Select RDI DLL ilil _ IDIEI
Il Fi= Edi Look in: [ 3 HTAG -] « @ ek E-
O =k
-|— |\ IFConfig
File: ENO_S- ) FDevice
Hot conne () HCanfig * _ &
Click to EJTarget e .I
TEm
4| » [\ Dem | 2=
= Hame AI
=
4 r [y Ce j
E ‘I
¥ T
File name: [H-To5.d T
Files of type: IHDI Target DLL j Cancel u
Search for &
earch for bex /L 4

7-10 i£$f H-JTAGDLL

s, W43 WE 7-11 Jror i Create New RDI Target % . ZEXANE Lo, AT LU 44
FIRT B IA, B R BN .

22 RYDEBUG [Unattached] 1ol x|
| ]
0| & & ke

L= 7 ™ Use the check boxes to add or remove RO targets from the connection manager:
File: ENO_SOL

i e ¥ [ T
—r CreateNewRDITarget I | .
pe—— Create New RDI Target X =
Not connect [ Remate_é J —I ==

Fligkito G @ PAulti-ICE Enter a name and a description for the new entiy in the j‘
1M &Rtulator conhection list;
Shorl =Dual FTOMI"):
4 L -
L s
= Hame ﬂ
= Drescripti “hiaalti j ":

H-ITAG __.__--';

0K I Cancel |
4| can: |
AddDLL... | Feset list | Configure... | Femave | Duplicate... | o
> readbos

Hone= Cloze
E 4| vy cmal —I
Currently opened File |Ln 1, Cal 1 | | | l—l_ v
7-11 Create New RDI Target % Il

L

41 [
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W a, M LUE S| H-ITAG B4 g RvDS L7, il 7-12 fios. fE FIEIH, #ids Configure
s, R P snr LLE 21K 7-13 Fios it H-JTAG 15 5. e 7-12 H1, 545 Close, RVDS FIBCLE &t 43 5¢

BT

¥DEBUG [Unattached]

[ O x
~a
_M |Uze the check boxes to add or remove RO targets from the connection manager: @ '
i 'ENO SOl
File: = Marme | Wersion | Dezcription |
I\Im.; Connect H-ITAG H-JTA r-d
CEicERCoNEe g:? Remate_a, wl.2 Angel debug protocol [zenal port] j‘
@ uilti-I CE w2 2 ARM JTAG debug interface [parallel port]
ARMulator vl.2 ARM inztruction zet simulator
® ol =
= Hame ;I
== |
|4|PIBC3II: [
Add DLL... I Rezet list | Configure... | FRemove | Duplicate... | =
» readhbos
HNonex Cloze |
5 KR =i
Currently opened File [tn 1, Colt | v

7-12 BB e

About H-JTAG

H-JTAG “er Mo [BUILD Date)

Hitp: v hitag. com
Hittp: 4 forun. hitag, com

Twentyone@hitag. com

Caopyright [C] Twentyone 2004-2008.

P

ok
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7.3 1AR HECE

IAR Embedded Workbench & IAR 23] H ) — 366 ARM ALFE2S ) IDE. 1 PR/ anfaf ic & 1AR
PLEE & H-JTAG #4718k

e, 1EIAR T HF—IH, 4R )5 fith Project->Options 25, Wi N K FR:

2 1AR Embedded Workbench IDE ] ] 4
File Edit Wiew | Project Tools ‘Window Help
DS @ AddFies... =4 Y %G 2 & |0
7 3 Add Group... _—
[———  ImportFile List...
It'l'nk5I “Intemal P B configurations. .
F”ES— Remove
B Elphytec_;
blink' Create Mew Project...
hellD | Add Existing Project...
Source Code Conkrol ¥
Make F?
Compile ChH+F7
Rebuild all
Clean
Batch build. .. F&
Stop Build
Overview | bink Debiag Chrl+D
Edit options For the  [M1ake & Restart Debugoer | 4

&l 7-14 IAR Options 3z

PRk, M AER N 7-15 Fizs it Options Bt & & H .
x|

Category:
C/C++ Compiler Target | Output I Library Configuration I Library optionz | MISRAS C
Assembler Proceszar wariant
Custorn Build
Build Actions " Core I.-’-\FEM?TDMI-S j
Linker
Debugger i+ Device IF'hilips LPC2234 Ek_l
Simulator
Angel
1&F RO-rnonitor i
J-Link/)-Trace fHore =l
tacraigor
RO ¥ Generate intenwork code
Third-Party Driver Proceszor mode Endian mode Stack align
£ Am " Little * 4 bytes
& Thumb " Big 8 bytes

o]

7-15 Options fit. & % 11

Cancel
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7 & 7-15 fir 7~ ) Options it & % 111, #%4% Debugger &, JF7E Setup JU, IXEhEIH Hk+E RDI.
W E PR

Options for node “blinky™ X

Categomny: Factory Settings |

General Optiohs

C/AC++ Carnpiler Setup | Downloadl Extra Dptionsl F'Iuginsl
Azzembler
Custorn Build Driver ¥ Runto
Build Actions @ [rain
Li
Alr:;el — Setup macros
IR ROM-maritor ™ Use macra file
J-Link)-Trace I J
td acraigor
RDI

— Device description file
[ Ovenide default

|$TDDLKIT_D|H$\EDNFIG\iDIpc2294.ddf J

Third-Party Driver

QK. I Cancel

7-16 Debugger W&

WG FIERE RDI W E, W NEPR. XA, WP FHE R E RDI KB BT,
x

Categomny: Factory Settings |

General Optiohs
TG+ Compiler ROl |
Azzembler .
Custam Build M anufacturer ROI driver
Build Actions Cqﬁ_ﬁ@itﬂwr RO driver 4__—?
Linker “Hote
D:i:.lujgforr I Allow hardware reset Usge the RDI menu to specify
Angel additional driver settings. (This
. menu is available after the RDI
4R ROM-maonitor [~ ETHM trace driver has been located)
J-LinkAJ-Trace

[ N

— Catch exceptiong——————————
% [ Feset [ Data [ FIO
_ : i — — oo

% 7-17 RDI X% &

USER MANUAL Copyright © 2010 WWW.HJTAG.COM All Rights Reserved 7-9



7 LR, i Browse #4414 H-JTAG 3% H sk N H-JTAGDLL, 1 R FTR:

Cateqary:

General Optiohs
C/C++ Compiler
Azzembler

Cuztorn Build

X

RDI

M arufacturer ROI driver

Factary Settings |

K 7-18 1%+ H-JTAG.DLL

5 B, i OK 4440, IAR [BEE TSR T . I EEWGE, IAR TR £ T —/ RDI 3¢H,

Wil 7-19 Fios. fESEHR ST Configure, lnl BAE 21 7-20 B i) H-JTAG OGS B

2 1AR Embedded Workbench IDE

7-19 I1AR % &5,
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K] 7-20 H-JTAG [ &

L /R
R AT VAR SR A I sy B4 ] FLASH H 3l R 808, 1 £E IAR ¥ Options 11, 15 AN 2] JT Verify
Download F11 Use Flash Loader(s)i 3. & Wi K B fin:

P 7-21 Verify Download 1 '&
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7.4 KEIL &

KEIL FOR ARM /& KEIL A w1 IDE. N2 ic & KEIL FOR ARM LIAE & H-JTAG #H4T
R

M H-JTAG V0.9.2 iR A, H-JTAG #4FH AGDI #: Nl A KEIL #EA TR, J5KkH RDI #2 M 7E KEIL
T H-JTAG 24 ] 411,

BH5E, FIEIT H-JTAG 22 H 3 R TOOLCONF.EXE 2%, *f KEIL 223% H 3% R ) TOOLS.INI it
BHHHATE R . W N K. i Config #2241, *F TOOLS.INI H#EHATECE, RJEiEH.

KEIL TOOLS.IMI

|D:'\KeiI\TEIEILS.INI

Config E it

K] 7-22 ToolConf For KEIL

PR, Wil AYE KEIL FXTIH BHATRCE . 5%, EHafT KEIL, H7E KEIL I —ANH, A
Ji #ish Project -> Options for Target... 3¢5, 41 K &l fis:

E_ Blinky - Mision3 - [D:\Keil\ ARM" Examples’Blinky'Blinky.c] - |D|ﬂ
Eile Edit  wiew Eroject| Debug Flash Peripherals Tools SWiCS Windomw Help oy = |
. |
é:l @ Mew Project. .. ﬂ M {ﬂ

Import p¥isionl Project. ..

@ &

CInEr, Braise)

%] 7-23 Options 3 i
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Rk, MM aBDE 7-24 Jii7n i Options it & & 1

Options for Target 'LPC2100" x|

Device  Target |Dutput| Listingl [ I Azm I L&anatel L.t’-‘n.MiscI Debugl Utilitiesl

Philips LPC2124
setal (MHz]: I [ BigEndian

¥ Usze On- ch|p ROM [0x0 - 03FFFF)

Mrerating sisham: IMnnp I | o N TR N I T T T T T R A T |

Philips LPC2124

Kial MHz] - BigEndian
V¥ Use On-chip ROM [0x0 - 0x3FFFF)
: ¥ ¥ Use On-chip RaM (040000000 - 0x40003FFF] Operating system: Mo

| 7-24 Options At & & 1

1L 7-24 Fin i) Options i & & 1, %% Debug W, W1 N K FiR:

x
Devicel Talgetl Dutputl Listingl [ I Azm I L&anatel L.t’-‘-.MlstllmesI

f=ion co oo pE— | [P | p—— | — il

W S Tl )y O =0 " ™~ ST =
Speed to Real-Time ™ Limit
1 Apphcation at Startup W Run to main() W Load Application at Startup W Run to main() W Loac
ion File: Initiahzation File: Initiahzat
e —————— » = - =l ———

DARMP.DLL pLPC21xx TARMP.OLL pLPC21xx

—

K] 7-25 Debug ¥ &
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7t Debug W& F, i M, winl LLE S H-JTAG ARM Fl H-JTAG CORTEX-M3 P> H-JTAG i
RIK)

(ILINE, Cartex Debugger

Dl Interface Driver

7-26 H-JTAG i IK5)

AR H AR, 7 LUESAE ] H-JTAG ARM 52 H-JTAG CORTEX-M3 i35, a1 &R,

Options for Target "Target 1' < . : xll

Device] Talget] Cutput | List,i_rgl Uger ] |:.-"|:-"-_.
Settings—l I : | ) Bl ﬂ Azm ] Linker Diebug

7-27 H-JTAG ARM
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5 FE, ST OK 424, [F13 KEIL 3% 1, KEIL 3R E RS T .
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